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Owner's Record

The model and serial numbers are located at the rear.
Record these numbers in the space provided below.
Refer to these numbers whenever you call upon your
Sony dealer regarding this product.

Model No.
Serial No.

To prevent fire or shock hazard, do not expose
the unit to rain or moisture.

To avoid electrical shock, do not open the
cabinet. Refer servicing to qualified personnel
only.

THIS APPARATUS MUST BE EARTHED.

This symbol indicates the equipotential
terminal which brings the various parts of a
system to the same potential.

This symbol is intended to alert the user to
& the presence of important operating and

maintenance (servicing) instructions in the

literature accompanying the appliance.

For the customers in the U.S.A.

This equipment has been tested and found to comply
with the limits for a Class A digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful
interference when the equipment is operated in a
commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction
manual, may cause harmful interference to radio
communications. Operation of this equipment in a
residential area is likely to cause harmful interference in
which case the user will be required to correct the
interference at his own expense.

You are cautioned that any changes or modifications not
expressly approved in this manual could void your
authority to operate this equipment.

The shielded interface cable recommended in this
manual must be used with this equipment in order to
comply with the limits for a digital device pursuant to
Subpart B of Part 15 of FCC Rules.

For the customers in Canada
This unit has been certified according to Standard CSA
C22.2 NO.60601.1.

For the customers in the U.S.A and
Canada

Model LPR-1000MD is Non-Patient Equipment.
This unit can not be used in the vicinity of patients.

* Patient Vicinity

Important safeguards/notices for use in
the medical environments

1. All the equipments connected to this unit shall be
certified according to Standard IEC60601-1,
IEC60950, IEC60065 or other IEC/ISO Standards
applicable to the equipments.

2. When this unit is used together with other equipment
in the patient area*, the equipment shall be either
powered by an isolation transformer or connected via
an additional protective earth terminal to system
ground unless it is certified according to Standard
IEC60601-1.

* Patient Area

ﬁ%

3. The leakage current could increase when connected
to other equipment.

4. This equipment generates, uses, and can radiate
frequency energy. If it is not installed and used in
accordance with the instruction manual, it may cause
interference to other equipment. If this unit causes
interference (which can be determined by
unplugging the power cord from the unit), try these
measures: Relocate the unit with respect to the
susceptible equipment. Plug this unit and the
susceptible equipment into different branch circuit.



Consult your dealer. (According to standard
EN60601-1-2 and CISPR11, Class B, Group 1)

Caution

When you dispose of the unit or accessories, you must
obey the law in the relative area or country and the
regulation in the relative hospital.

Warning on power connection

Use a proper power cord for your local power supply.

1. Use the approved Power Cord (3-core mains lead) /
Appliance Connector / Plug with earthing-contacts
that conforms to the safety regulations of each
country if applicable.

2. Use the Power Cord (3-core mains lead) / Appliance
Connector /Plug conforming to the proper ratings
(Voltage, Ampere).

Warning on power connection for
medical use

Please use the following power supply cord.

With connectors (plug or female) and cord types other
than those indicated in this table, use the power supply
cord that is approved for use in your area.

United States Canada
Plug Type HOSPITAL GRADE* HOSPITAL GRADE*
Female end E62405, E35708 LR53182, LL022442,
LL088408
Cord type E159216, E35496 LL112007-1, LL20262,
Min.Type SJT LL32121, LL84494
Min.18 AWG Min.Type SJT
Min.18AWG
Minimum cord set | 10A/125V 10A/125V
rating
Safety approval UL Listed CSA

*Note: Grounding reliability can only be achieved when the equipment
is connected to an equivalent receptacle marked ‘Hospital Only’ or
‘Hospital Grade’.

EEAReE
(For Customers in Taiwan only)
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Introduction

About This Manual

The following manuals are supplied with the LPR-
1000MD printer.

Setup Manual

Be sure to read this manual, first.

This manual gives advice including operating
instructions, for tasks you should perform before you
make printouts using this printer after you purchase it.
This manual also gives advice on installing the printer,
information on locations and functions of parts and
controls, information on assembling the printer,
information on connections to the computer and setup
required for using the printer, and advice on installing
and uninstalling printer drivers, and so on.

Instructions For Use (this manual)

The Operating Instructions manual is included on the
CD-ROM in PDF format.

Read this manual before starting actual printing.

This manual describes basic operations and functions, as
well as how to use the LPR-1000MD. It includes
information on basic operating procedures, how to setup
the various printing methods, maintenance,
troubleshooting, and so on.

CD-ROM

This disc includes the printer drivers, and PDF files of
the multi-lingual Instructions For Use and Setup
Manual.

Help window

An explanation appears when you click the “?”” mark on
the upper right of the window of the printer driver or
when you click the “Help” button.

Read this manual when you are in trouble.

Conventions used

Cross references

Throughout this manual you will find references to other
sections of the manual that contained related
information.

Also, when the related information is contained in the
printed Setup Manual, you will find the title of the
printed Setup Manual.

Important note
Be sure to read sections of the manual marked m
To prevent damage and avoid trouble or unexpected

results, pay careful attention to these precautions, and
the “Precautions” on page 50.

Operation panel display

On the operation panel display of the printer, messages
are displayed on two lines. In this manual, a slash (/) is
inserted between information displayed on the upper
and lower lines.

Ink level
Black (BL)

Ink level /Black (BL)

Windows screen
In this manual, Windows XP screens are used for
explanation.

About This Manual
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System Overview

The Sony LPR-1000MD is an ink jet printer which is
equipped with a high-speed line shot.
The LPR-1000MD has the following features.

High-speed line shot

The printer is equipped with a high-speed line shot.
Since the line shot method is applied, the ink is sprayed
out at a stretch while the paper passes under the print
head of the longer page width to print the pictures and
characters of the print data. It takes only six seconds for
the paper to pass under the print head. That is the actual
printing time. Also, the optimum LD shot technology is
incorporated in the line shot.

A quiet printer for a work-friendly environment
Use of a fixed-type print head reduces the noise or
vibration which occurs while the print head is printing.
This allows you to enjoy a quiet, work-friendly
environment.

USB connector
The printer is equipped with a USB connector.

Pure paper extracting the printer
characteristics

The EPP-300A4MD Sony High Quality Paper (not
supplied) comes in 100 sheet packs and has good color
and a high degree of whiteness. Since this coated paper
absorbs the ink quickly, printouts without blotted
characters and with clear, high-quality images can be
made.

System Overview / Location and Function of Parts and Controls

Location and Function
of Parts and Controls

The following diagrams show the printer after it is
assembled.
For details, see the pages indicated in parenthesis.

Front

|I| Head cover (44)
Open this cover to replace the ink cartridges.

Main cover (57)
Open this cover when removing jammed paper or
correcting a situation where the supplied head
cleaning unit is not inserted correctly.

Output slot
Printed sheets (printouts) are ejected here.

[4] Output support (13)
Pull out this output support to hold the ejected

paper.

[5] Auto sheet feeder tray (12)
Individual sheets of paper are loaded automatically,
one at a time.



[6] Operation panel

®

() ON/STANDBY button/indicator (9, 10)

Used to switch the printer to on or to standby status.
When the ON/STANDBY button is set to on, the
power is on and the indicator lights in green. When
the printer is in standby mode, the indicator lights
in orange. To restore the power from the standby
mode, push the ON/STANDBY button again. In the
standby mode, the printer does not print, however,
power is saved. When the printer is not used for a
long time, it is recommended that you turn the
printer off. To turn the printer off, set this ON/
STANDBY button to the standby mode and set the
main power switch on the rear panel to off.

If the main power switch on the rear panel is not set
to on, the power is not on, even though the ON/
STANDBY button on the front is set to on.

READY button/indicator (9, 10, 46, 56)

Used to set the printer so that it is ready to receive
data from a computer so that it can be printed.
When you push the MENU button during setup,
when confirming the status, or performing
maintenance, the READY indicator goes off. When
the READY indicator is not lit, the printer cannot
print. If the READY indicator is not lit when you
want to print, push the READY button so that the
indicator will light.

Also, if you push the READY button during
printing, the READY indicator starts blinking and
the printer stops printing temporarily. To restart
printing, push the READY button again.

For detailed information on the relationship
between the ON/STANDBY indicator and the
READY indicator, see ‘“Relationship Between the
ON/STANDBY Indicator and the READY
indicator” on page 10.

Printer window display (Liquid Crystal Display
(LCD)) (41, 42, 46, 55, 62)

Displays messages during setup, when confirming
the status, or performing maintenance.

MENU button (41, 42, 46, 62)
Push this button to display the menu on the LCD.

SET button (41, 42, 46, 63)
Used to execute the operation displayed on the
LCD and to go to the next operation/step.

<4<4/» P (select) buttons (41, 42, 46, 62)
Used to change setting items or the numerical
values displayed on the LCD.

BACK button (63)
Used to cancel the condition displayed on the LCD
and to go back to the previous step.

Eject buttons (57)

Provided on both the left and right sides of the
printer.

Used to open the main cover when removing paper
jammed inside the printer, and so on. Push both left
and right buttons so that the main cover pops open
and you can pull it upward.

When the Head Cover is Opened

[1]

Label
Shows the note on handling the head cover.

Head cartridge cable
Provided to supply power to the head cartridge.

Head cartridge

This head cartridge is equipped with a print head.
The ink sprays out from the print head when
printing.

Location and Function of Parts and Controls
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(4]

Head cartridge lock screws (three positions)
Used to lock the head cartridge. Do not move these
screws from the lock position.

Ink cartridge holder (43)

One black ink cartridge holder and one gray ink
cartridge holder are attached. If one of them runs
out, the printer cannot print.

Use the following ink cartridges for replacing.
Black: EPI-L100BL Sony Ink Cartridge
Gray:EPI-L100GL Sony Ink Cartridge

Rear

¥ USB connector (60)
Connects the supplied USB cable.

Ventilation holes (51)
Provided to prevent the printer from overheating.

Equipotential ground terminal connector

Used to connect the unit to the equipotential plug of
peripheral equipment to bring the various parts of
the system to the same potential.

Refer to “Important safeguards/notices for use in
the medical environments” on page 2.

~AC IN connector

Used to connect the printer to a wall outlet with a
power cable.

Refer to “Warning on power connection” on page 3
and “Warning on power connection for medical
use” on page 3.

Main power switch (9)
This is the main power switch of the printer. Used
to turn the printer on or off. When this switch is set

Location and Function of Parts and Controls

to on, the power to the printer is on when the ON/
STANDBY button on the front panel is set to on.

Note on turning the main power off

The printer may automatically perform
maintenance operations when print operations are
not being performed. Also, when the printer is set to
standby mode by pushing the ON/STANDBY
button, the printer may also automatically perform
maintenance tasks so that the printer will work
properly when the power is turned on again. After
this maintenance is performed, the printer is reset to
standby mode. During maintenance, the READY
indicator blinks and the printer moves to the
standby mode after completing the maintenance.
Before turning the main power off, be sure to set the
printer to the standby mode by pushing the ON/
STANDBY button, and then set the main power
switch to off.



Turning the Printer On/
Off

Turning the Printer On

Turn the printer power on after you connect the AC
power cord.

For detailed information on how to connect the AC
power cord, refer to “Turning the Printer On” described
in the printed Setup Manual supplied with the printer.

Be sure to remove the sponge stopper attached inside the
printer at the factory before connecting the AC power
cord.

For detailed information on how to remove the sponge
stopper, refer to “Sponge stopper” described in the
printer Setup Manual supplied with the printer.

To turn the printer on
Set the main power switch to the ON (l) side.

Main power switch

The ON/STANDBY indicator lights up in orange and
the printer starts.

When both the ON/STANDBY and READY indicators
light in green after a while and “READY” appears on the
printer window display, the printer is ready to print.

REY
8 0 e

READY

Lit (green)

Lit (green)

Setting the Printer to Standby Mode

In standby mode, the printer cannot print. However, the
power can be saved when the printer is not being used.

To set the printer to standby mode

Push the ON/STANDBY button.

The ON/STANDBY and READY indicators light in
orange and the printer enters the standby mode.

ON/
O | STANDBY
©)

) ON/STANDBY
button

To restore the printer from standby mode

Push the ON/STANDBY button again.

The ON/STANDBY and READY indicators light in
green and the message “READY” appears on the printer
window display.

Turning the Printer Off

Use the ON/STANDBY button placed on the front of the
printer to turn the printer on or off during daily use.
When you do not intend to use the printer for a long
time, turn the printer off as follows.

1 Push the ON/STANDBY button.
The printer enters in standby mode.

Turning the Printer On/Off
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2  Setthe main power switch placed on the back of the
printer to the OFF (O) side.

Be sure not to set the main power switch to the OFF (O)
side directly. Set the printer to standby mode once, and
then set the main power switch to the OFF (O) side. The
printer turns the power off after it performs maintenance
so that it will start in good condition when the power is
turned on next time.

Indicator status

Printer status

ON/
T STANDBY
[0}

T READY

The printer is in setting
mode, confirming mode or
maintenance mode.

The printer cannot print.

Relationship Between the ON/
STANDBY Indicator and the READY
indicator

You can confirm the status of the printer according to the
lighting status of the ON/STANDBY and READY
indicators placed on the front panel.

Indicator status Printer status

Lit Not lit
(Green)
The ON/STANDBY button
M on was pushed while printing
’/T{ T T was in progress.
After completing a print
Blinks Lit job, the printer goes to
(Green) (Green) standby mode.
or
/Tl READY
/\
Blinks
(Green)

The printer is turned off.

ON/
T STAI\IIDBY T READY
O

Not it Not lit
The printer is in standby
.
b
Lit Not lit
(Orange)

ON/
T STANDBY
)

Lit
(Green)

T READY

Lit
(Orange)

Set the main power switch
placed on the back of the
printer to the OFF side,
then set it to the ON side
again.

If the printer does not start
correctly even after you
perform the above
operation, the printer has
malfunctioned. Contact
your dealer.

Initializing (Starting)
Wait for a while.

ON/
T STANDBY
[0}

Lit
(Green)

\\ /
/Tl READY
/N

Blinks
(Orange)

An error has occurred.
The error message is
displayed on the printer
window display.

Solve the problem,
referring to “Error
Messages” on page 54.

Q /# ON/
~@TSTANDBY READY
i)t
Blinks Not lit
(Orange)
Print mode
The printer is ready to print.
STANDBY READY
e I
Lit Lit
(Green) (Green)
The printer is cleaning the
ON/ RY; print head. Or the printer
T /}T\ has stopped printing
temporarily because the
Lit Blinks READY button was pushed
(Green) (Green) while printing was in
progress.

Turning the Printer On/Off



Preparing Paper

Recommended Paper

Be sure to use the paper recommended.

It is required to perform settings of Paper on the Main
tab in the Printing Preferences dialog box.

For detailed information on settings for paper, see
“Settings for Paper” on page 17.

Setting for the Media
Type in the Printing
Preferences dialog

Sony High
Quality Paper

Plain Paper

Number of sheets Up to 60 sheets Up to 100

which can be loaded in sheets

the auto sheet feeder

tray

Number of printed Up to 30 Up to 30
pages which can be printed pages  printed pages

ejected on the tray
Size A4 A4
Paper loading method

Place papers in
the auto sheet  the auto sheet
feeder tray, feeder tray,
facing the more facing the
whitish side printing side

Place papers in

down. down.
Sheet feeding method  Automatic Automatic
paper feeding  paper feeding
Product name EPP-300A4MD Plain paper
Sony High Plain recycled
Quality Paper  paper
(300 sheets)

The number of printed pages which can be ejected the
maximum number. In actual printing, the number of
printed pages which can be ejected may be reduced
depending on use environment where the printer is used.

Notes on using paper other than paper

manufactured by Sony Corporation

* When using mat coated paper manufactured by
another company, the number of sheets which can be
loaded and ejected depends on the thickness of the
paper. Thus, those numbers may be different from
ones listed on the above table. In the case of double-
sided mat paper, the number of sheets may be about 20
pages.

* It is recommended that you use mat coated paper with
a thickness between 0.1mm and 0.27mm.

* You cannot use the following paper:
Plain paper whose weight is less than 6Og/m2 or
higher than 105 g/mz.

Available Printing Area

To maintain the quality of print, margins are set at the
top, bottom, right and left of the paper. The range on
which text or images can be printed is the area inside
these margins.

Available printing area
200 x 287 mm (width x height)

5.0mmi¥iii
5.0mm :%::'_
A HE
b > i
5.0mm 5.0mm

Notes on Paper

Notes on handling paper

* When holding paper, hold it at both ends of the sheet

s0 as not to touch the printing surface. Dust, scratches
or finger prints on the paper are likely to cause
unsatisfactory printing.

* After printing, do not touch the surface printed until
the ink dries. Also, if you wet the printed sheet with
water, do not touch the surface printed until it dries.

* There are some types of paper whose printed surface

warps and is rubbed when printing photos or graphics
using a large amount of ink. This type of paper is not
suitable for printing photos or graphics. Use this type

of paper when printing print data consisting of
characters or text.

When storing paper

 Use the original package for unused paper.
* Avoid storing paper in a location subject to:
— high temperatures
— high humidity
— excessive dust
— direct sunlight

¢ Place the unused paper on a flat surface so that it will

not warp or bend.

Preparing Paper
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Unsuitable paper

Do not use the following paper. Doing so is likely to

result in malfunctions such as paper jams.

* Folded paper

* Warped paper

* Wrinkled paper

* Wet paper

* Thin paper (less than a weight of 60g/m2)

* Thick paper (more than a weight of 105 g/mz,
excluding paper manufactured by Sony Corporation)

 Paper with holes (such as loose-leaf paper)

Loading Paper

Loading Paper

The printer feeds paper automatically one sheet at a time
from the auto sheet feeder tray (supplied).

To load paper, follow the procedure below. Be careful
not to touch the printing surface.

1 Remove the auto sheet feeder tray.
If you use the printer for the first time, skip this
step. Start from step 2.




3 Move the paper guides (vertical and horizontal) to
the ends.

Paper guide (horizontal)

Paper guide (vertical)

4 Riffle the paper so that it is even.

Be careful not to touch the printing surface.

z \\ =
V. L1
%—./,

When plain paper is used, place the paper in the
auto sheet feeder tray so that the printing surface
faces down. When Sony High Quality Paper is
used, place the paper in the auto sheet feeder tray so
that the more whitish side faces down. Then, secure
the paper in place by sliding the paper guides
inward towards the paper.

Set the paper securely
at this point.

Place the paper in the
auto sheet feeder tray
with facing the printing
surface down.

* Place the paper against the back of the auto sheet
feeder tray towards the left side.

* Place the paper with the long side placed
vertically and the short side horizontally.

6 Reattach the cover to the auto sheet feeder tray and

insert it into the printer.

When printing, be sure to pull out the output support
completely. If it is pull out halfway, the paper may
jam.

The number of sheets which the automatic paper
feeding tray can hold depends on the type of paper in
use. For detailed information on the maximum
number of sheets which can be loaded, see page 11.
Do not mix different types of paper in the auto sheet
feeder tray.

To remove jammed paper, push the READY button,
blinking in orange. The jammed paper is
automatically ejected. Should the jammed paper
remain after you have pushed the READY button, see
“If the Paper Jams” on page 56.

Do not use paper listed in “Unsuitable paper” on page
12.

Do not pull the paper out when printing has started and
the paper is being fed. Doing so is likely to result in
malfunctions or paper jams.

It is often difficult to feed paper from the auto sheet
feeder tray, or sometimes it may be fed at an angle,
depending on the usage circumstances. In such a case,
add one sheet of the same type of paper in the auto
sheet feeder tray and try to print again.

The paper may warp depending on the circumstances
and the warped paper may stick up out from the auto
sheet feeder tray. In this case, the printer will not be
able to feed the paper. Try to make the warped paper
lie flat or reduce the number of sheets set in the auto
sheet feeder tray.

Loading Paper

13
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When plain paper is loaded in the auto sheet feeder
tray, if a different media type is selected on the Main
tab of the Printing Preferences dialog box, the printed
paper may not be ejected correctly. For detailed
information on how to select the media type, see
“Settings for Paper” on page 17.

Loading Paper



Operation

Performing Basic Print
Settings

Displaying the Print Preferences
Dialog Box from a Software
Application

When printing from a software application such as word
processing software or image processing software,
perform print settings using the following operating
procedures. Depending on a software application, the
method to display the Printing Preferences dialog box
and the dialog boxes may be a little different. In this
section, WordPad on Windows XP is used for
explanation.

1 Select [Print] from the File menu in software
application.

i | Document1 - Microsoft Word

Eile | Edit  ‘Wew Insert Format 1

[ dew... ChHN b
T Open.., Chrl+0 '.—

Close Ii

Save Chrl+s
Save As.., |

\§§ Save as‘Web Page...

By Search... |
‘Web Page Preview ‘
Page Setup...

@_ Print Prewiew ‘

[@; Print... ke ||
Send Ta 3 |

Frit

The Print Settings dialog box appears.

2 Select [Sony LPR-1000MD] from the list, and then
click the [Preferences] button.

& print @@

General

Select Printer

[ Print ta il

Statug; Ready
Lacatior

Comment: Find Printer.
Fage Range
@Al Mumber of copies: 1 |
() Pages 1-RRARIG _!_i_g - 3
Enter either a single page number ar a single 112 12
page range. For example, 512

)

The “Sony LPR-1000MD Properties” dialog box

appears.
# Sony LPR-1000MD Properties. B
Main | Layout | Funetion
Paper Ine:
= Fol Pt o @ Black and White(B)
T T a—— W
widtw) [ . Banmslll
Gamma2(2]
Lenghit] [ 7 =f PO
et Media Typelk) [Sory High Qualiy Paper =1 || ¢ Gammatig
Sarctd &l ol ml ol e
= A=

3 Perform the required settings on the Main tab,
Layout tab, and Function tab respectively.
For detailed information on how to perform settings
on each tab, see the corresponding pages of each
tab.
“Performing Settings on the Main Tab” on page 17
“Performing Settings on the Layout Tab” on page
19
“Advanced Functions” on page 26

4 After the required settings have been completed,
click the [OK] button to start printing.

Displaying the Printing Preferences
Dialog Box from the Windows Start
Menu

When you want to change the settings of the printer or
perform cleaning or maintenance regardless of the
special application software, use the following method.
Depending on the version of your Windows operating
system, the method used to display the Printing

Performing Basic Print Settings
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Preference dialog box and the dialog boxes may be a The “Sony LPR-1000MD Printing Preferences”
little different. In this section, Windows XP dialog boxes dialog box appears.
are used for explanation.

. h op; 5 rinting Preferences,
1 Sselect [Start], [Control Panel], [Printers and other A L
hardware], and [Printers and Fax], in turn, so as to e "
. . . _—
display the Printer window. vl ([saran ||| e
Paper Sizelz] |4 ~ e
. . i . & Gamnal[l)
2 Right-click [Sony LPR-1000MD], and then select el j & il
. LengthiL) D B
[Properties] from the context menu. N e B D
66 ol e e
% Printers and Faxes Ca
File Edit View Favortes Tools  Help F
D 2 | Pseaen Fdes | 5 (30 X ) |-
Address |93 Printers and Faxes | Ed & A . .
- — 4  Perform the required settings on the Main tab,

% b oy Lp-1000mD) > :
(52 "rmer @ b ) . Layout tab, and Function tab respectively.

—_ For detailed information on how to perform settings
on each tab, see the corresponding pages of each

ﬁ°”" ez PRH000 Printing Freferences, .

Offling
IE¥ Pause Printing

Sharing. .. tab.
ii;ffﬂt “Performing Settings on the Main Tab” on page 17
L “Performing Settings on the Layout Tab” on page

Rename

19
“Advanced Functions” on page 26

5 After the required settings have been completed,
The “Sony LPR-1000MD Properties” dialog box click the [OK] button.

appears.
About the Printing Preferences dialog box

3 Click [Printing Preferences...]. The Sony LPR-1000MD Properties dialog box which
appears when you click the [Properties] or [Preferences]
button after displaying the Print Settings dialog on the

&Sy LR ADDOUD Prupeiies ol software application or the Sony LPR-1000MD Printing
setess | o] Pt pevacees ] Enodiiopmin Preferences dialog box from the Windows Start menu
\.‘; [5on, LPR000MD | are basically same window and have similar functions.
Location: | ‘
| | Common Operations on Each Tab
| Mo Sevtil | of the Printing Preferences Dialog
Caolor:Yes .Papar available: B ox

Double-sided: Unknown
i The following operations are common to each tab.
* [&](Save) button (pages 34)
Click to save the current settings as a named file.
(Fiting Proforences | * [&](Retrieve Settings) button (pages 36 and 37)
A — Click to retrieve the saved settings.
T * [&|(Utilities) button
Click to display the Utilities dialog box when
performing print position adjustment (page 25), head
cleaning (page 40) and test printing (page 42).
* [@|(Version) button
Click to display the version information of the printer
driver.
* [@|(Help) button (page 23)
Click to display the help window which gives
operating instructions on the Printing Preferences
dialog box.

Speed. Unknown

Mauirnum resolution: 500 dpi

1 6 Performing Basic Print Settings



¢ [OK] button
Click to execute the settings or changes made to
previous settings, or to start printing.

¢ [Cancel] button
Click to cancel setting operations done in the dialog
box.

Paper:210mm 237mm

& Sony LPR-1000MD Printing Preferences (&3]
Main | Layaut | Function
Paer Ink
| — P
Tray(T] [uto Shest Fesder ~ ©iflackand a(B]
Paper SizelZ) ’M Gtuns e
widkta) [ || Gemmel]
 Gamms22)
Lengthil]
o € Ganmedd)
)

Bedia Typelk] [Sony High Quslty Paper  Garmad(d

ForiailLapout
Scaing 12t 100 %
Stamp(None) [ ﬂﬂgg

Common features

Performing Settings on
the Main Tab

The Main tab allows you to perform the following basic
settings required for printing.
* Paper
— Tray (paper feeding method)
— Paper size
— Media type
e Ink
This printer supports only black and white printing.
* Gamma type
Sets the quality level of the printouts.

Main tab
& Sony LPR-1000MD Printing Preferences, &3]
Paper Ik
| — &
Trall) [Auto Sheet Fecder - CeRlack and Yol
PaperSizsi2) [A4 = |rhE=ee
i) [ = & Gammal (1)
" Gamma2(2]
LengthlL)
j i " Gamma3(3]
Paper210mm X 297mm
Potrait] Layout Media Typelk) |Sony High Quality Paper A © Gammad()
Sealing ratie:100 %
Stamp:[None] e
BlA &0 e

Settings for Paper

1 Click the [Main] tab.
The Main tab dialog appears.

2  Select the proper settings according to the paper
loaded in the auto sheet feeder tray.

%_ Sony |LPR-10008D Printing Preferences

Main | Layout | Function

Paper

~—®
idth(] —

LengthiL) —| mm

1—0

[ e

I Pope Sizel@) |44

Paper;210mm ¥ 237mm
Portrait] Lagout

Scaling ratio:100 %
Stamp:[Mone)

I Media Type(k) ‘SOI’UJ High Quality Paper

® Tray
Since the printer corresponds to automatic
paper feeding system, “Auto Sheet Feeder” is

Performing Settings on the Main Tab
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automatically selected. Another tray type can
not be selected.

Size

Since the printer corresponds to size A4, “A4”
is automatically selected. Another paper size
can not be selected.

© Width and Length
The width and length of A4 paper sheets are
displayed. You cannot adjust the width and
length since they are fixed.

® Media Type
Click [ V] to select the type of the paper loaded
in the tray. The printer performs printing
suitable to the media type selected.
For detailed information on media types, see
“Recommended Paper” on page 11.

3 Click the [OK] button.
The settings appropriate to the paper are saved.

Gamma type Comments

Gamma 1 To make a printout of a normal
image.

Gamma 2 To emphasize the half tone.

Gamma 3 To emphasize the bright portions.

Gamma 4 To emphasize the bright portions,

the halftones, and the dark parts.

Selecting the Gamma Type

You can set the quality level of the printout.
You can select the gamma type according to the print
data and the purpose of the printout.

1 Click the [Main] tab.

2  Click the radio button corresponding to the desired
gamma type.

Ik

@ Black and white(B]

Gamma Type

& Gammal(l

" Gamma2(2

]
|

it Gamma type
]

" Gammad(4

alalalol e

o] [ cancel [ ooy |

Performing Settings on the Main Tab

3  Click the [OK] button.

The setting of the gamma type is saved.



Performing Settings on
the Layout Tab

The Layout tab allows you to perform the following
settings.
* Orientation
You can select the orientation of printouts.
* Page layout
— Printing multiple pages per sheet
You can specify the number of pages of printing data
to be printed on a single sheet.
— Poster
You can divide one page of printing data onto
multiple sheets.

Layout tab

& Sony P L1000MD Printing Praferences

Diientation Pags Layout

& Poitrai | ' Pinting multiple pages per shest(w/)

-I  LandscapelL)  FosterM)

Tpage k|

Blalz el e

Setting the Print Orientation

You can select portrait or landscape orientation for
printing.

To print multiple pages on one sheet, be sure to set the
orientation, and then select the layout of the page.

The setting of portrait or landscape orientation depends
on the page setting of the printing data. When the page
setting is not included in the printing data, printing is
carried out according to the setting made using the
following procedure.

1 Click the [Layout] tab.
The Layout tab dialog box appears.

2 Select the [Orientation].

Portrait/Landscape

ng Preferences

| orientation - Page Layout-

& Printing multiple pages per sheet{w]

" LandscapelL] " Paster(M]

1page =l

Alalel el el
o o]

Orientation Comments

Portrait To print the printing data in portrait
orientation when the page layout is

not set in the printing data.

Landscape To print the printing data in
landscape orientation when the page

layout is not set in the printing data.

The setting of portrait or landscape orientation of
the page is automatically switched according to the
page layout of the printing data. Therefore, even if
the [Portrait] setting is selected, the printer may not
print the printing data in portrait orientation.

3 Click the [OK] button.
The orientation setting is saved.

Printing Multiple Pages on One
Sheet

You can specify the number of pages of printing data to
be printed on a single sheet.

1 Click the [Layout] tab.
When printing one page on one sheet, go to step 3.
When printing multiple pages on one sheet, go to
step 2.

Performing Settings on the Layout Tab
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2 Setthe print orientation.

Portrait/Landscape

Pags Layout

Orientation

ng Preferences @E

& Printing multiple pagss per shestfw]

& PortratiF}
I Landscapsll) © Posterit]
1page =]

ETHETE - K]

Set the print orientation using [Orientation]

according to the page orientation
data.

of the printing

3 Click the [Printing multiple pages per sheet] radio

button in the Page Layout group.

[Printing multiple pages per sheet]

Page Layaut

I’-': Printing multiple pages per sheelM]I

" PosterM]

1page LJ

4 Cciick [¥] and select the pages to be printed on one

sheet.

Page Layout
4 Printing multiple pages per sheet(w)

" Poster(i]

Click [V] .

20 Performing Settings on the Layout Tab

B

To print one page on one sheet

Select [1 page].
When the print orientation is set to [Portrait]:

AR -

When the print orientation is set to [Landscape]:

TN ~

To print two pages on one sheet

@ Select [2 Page].

@ Select the page layout to be used on the page.
When page orientation is set to [Portrait]:

When page orientation is set to [Landscape]:

To print four pages on one sheet

@ Select [4 Page].

@ Select the page layout to be used on the page.



When page orientation is set to [Portrait]

R ~

When page orientation is set to [Landscape]:

5  Click the [OK] button.
The setting for the printing of multiple pages per
sheet is saved.

Printing Single Page Printing Data
on Multiple Sheets

You can divide single page data and print the results on
multiple sheets.

1 Click the [Layout] tab.

2  Setthe print orientation according to the page
layout setting of the printing data.

Portrait/Landscape

ng Preferences @@

Orientation Page Lapout

& Printing multiple pages pet shestw]

" Landscapell]

© PasterlM)

Tpage =]

Blol s el el

3 Click the [Poster] button on the Page Layout group.

-~ Page Layout

" Printing multiple pages per sheet(w]

dpage(2n2] - i

[Poster]

4 Click [V¥] and select the dividing method.

-~ Page Layout

™ Printing multiple pages per sheet(u]

4page(2x2] | % 1 I

Click [V].

Performing Settings on the Layout Tab
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Item

Comments

4 Page (2 X 2)

To divide one page of printing data
and print the results on four sheets.

9 Page (3 X 3)

To divide one page of printing data
and print the results on nine sheets.

16 Page (4 X 4)

To divide one page of printing data
and print the results on 16 sheets.

5  Click the [OK] button.
The poster setting is saved.

Using the Help Window

Using the Help Window

On the Printing Preferences dialog box, you can display
a description of functions or operation methods using
the help window.

To display the Printing Preferences dialog box, see
“Displaying the Print Preferences Dialog Box from a
Software Application” on page 15 or “Displaying the
Printing Preferences Dialog Box from the Windows
Start Menu” on page 15.

Displaying the Description of
Functions of Setting ltems

1 click [?] at the right top on the Printing Preferences
dialog box.
The pointer changes to a?.

[?] button

& Sony LPR1000MD Printing Preferences

Main | Lyoul | Funclion
Paper (i
L —
(S
Tiay(D) o Sheet Feeder - Hiegearelvhiabl
PaperSizelZ) [A4 | | esee
widbts) 2] & Gonmall)
 Gamma2(2)
LengthlL) mm
E  Gammadld)
Peper21 Onm 237mm —
Lk Meda Topelk) [Sony Hioh Quaity Popet =] | | 1~ Gttt
Scsling a6 100 %
StampNane) S
glooloe
= e |

2 Click the setting item whose function you want to

know about.
A popup window describing the function of the

setting item appears.

Main | Layaut | Function|

Paper
|

Selects the automatic sheet Eheet Feeder
feeder tray.
Paper Sizels] A4

3 Click any point on the window to close the popup
window.




Displaying Information on
Operation Methods

You can display detailed information on an operation
method by searching it using the table of contents or a
keyword.

1 Click the (Help) button at the right down of the
Printing Preferences dialog box.

& sony LPR-1000MD Printing Preferences

| Main | Lapout | Funetion
Paper Ik
-_—
@ Black and Whie(E)
TialT) Auto Sheet Feeder 7
Paper Size@) [2a & R |
3 |
ki) = @ Gammal 1)
© Gamma2(@) |
Lenghll) o
= © Gammadd)
Paper210nm X 257mm
PormeiLagout Media Tygelk) [Sany High Qualiy Paper ~ ~  Ganmat(e) ‘
Scalingratio:1 00 %
Stamp (Hore) ololmle jﬂ
G

(Help) button

The help window appears.

2  Search for detailed information on the operation
method which you want to know about by clicking
the [Contents] tab or [Index] tab.

E? Sony L PR-1000MD

Al
Hide  Back Formard

Lontents | |ndex | Search |

=] Sony LPR-1000MD

Main

Tray (sheet feeding method)

The printer uses & system where the paper is fed from sn suto sheet feeder tray:
Ancther tray typs cannot be selected,

[Notes on using the suto sheet faeder tray]

= ® Flacs the peper in the suto sheet feader tray 5o that the printing surface
,— [E]1<Settings>S¢ oo

LTJ e & Place the paper mith the long side towards the lefi side afthe tray and place
(5] Print quality the top end of the paper tomards the back ofthe auto sheet feder thay. (Be

@ Lavout sure to place the psper with the printing side facin down and its lons side

@ Function Squared offvertically and the short side squarsd off horizontalty, s2en Fom
the front sids of the printer.)

@ Saving print setting

® Lty & Securs he psper with the paper guides inside the auto Sheet feeder tray

] Eirormessages: & Reattach the couer of the tray The cousr also functions as the sject tray.

3 Click [X] at the top right of the help window to
close the help window.

Cancelling a Print Job

You can cancel the print job using one of the following

three methods after you click the [Print] button.

 Cancelling the print job from the Windows spooler
window (page 23)

¢ Cancelling the print job from the status monitor
(page 24)

* Cancelling the print job from the operation panel of
the printer (page 24)

Cancelling a Print Job from the
Windows Spooler Window

1 Select [Start], [Control Panel], [Printers and other
hardware], and [Printers and Fax], in turn, so as to
display the Printer window.

2 Double click [Sony LPR-1000MD].
The Windows spooler window appears.
You can cancel the print job in this window.

3 Right click the job you want to cancel, and select
[Cancel] from the drop down list.

& Sony LPR-1000MD.

Printer Document  View  Help

Document Hame Status Cuiner Pages Size: Subr

@ Printing User 1 72 bytes/113KB  &:05

* Pause
Restart

|

< Properties T | ¥

Cancels the selected documents.

The following confirmation message appears.

:.’/ Are you sure You want to cancel the selected print jobs?

[ ves [ |

4 Click the [Yes] button.
The selected job is cancelled and disappears from
the spooler window.

5 click [X] at the right top corner to close the spooler
window.

Cancelling a Print Job
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Cancelling a Print Job from the
Status Monitor

1 Double click the [iJ icon on the task bar to open the
status monitor.
When printing starts, the status monitor
automatically starts and the [i] icon appears on the
task bar.

2  Click the [Job] button.

LPR-1000MD Status Monitor X

[k Level

Status

Mow printing.

Enor

Mo abriomnalities

- Make sure the printer shows "READY"",
- Click, "Canicel Print Job" button below to cancel

1ol
- Reprint thiz job after the printer "READT"

I
Click the [Job] button.

The Windows spooler window appears.

3 Right click the job you want to cancel and select
g Jjoby
[Cancel] from the drop down list.

& Sony LPR-1000MD.
Printer Document Yiew Help
Docurnent Manme Status Owner Pages Size Subr

@ Printing User 1 72 bytes/113 KB 8:05

Pauise

< | Propertis 5

(Cancels the selected documents,

24 Cancelling a Print Job

The following confirmation message appears.

4 Click the [Yes] button.
The print job is cancelled and the selected print job
disappears from the Windows spooler window.

5 click [X] at the right top corner to close the
Windows spooler window.

Cancelling a Print Job From the
Operation Panel of the Printer

You can cancel a print job which is just starting from the

operation panel of the printer.

This method is to be used when you want to stop a

printing job while printing multiple sheets.

It can be used in the following two situations:

* When the printing data is left on the spooler window,
first, cancel the job from the spooler window
following instructions given in “Cancelling a Print Job
from the Windows Spooler Window” on page 23, and
then perform the following operation.

* When the printing data has been sent to the printer and
the print job is not displayed in the spooler window.

_ READY =
o LT Lo

|/
5 Printer window display 2

The page currently being printed is printed.

1 Push the MENU button on the operation panel of
the printer.



The READY indicator goes off and the message
“Ink level” appears on the printer window display.

Ink level
Black (BL)

2 Keep pushing the MENU button or the [P] button
until the message “Print job cancel” appears.

Print job cancel

3 Push the SET button.
The message “Cancel print job?/Yes_

’

Cancel print
job? Yes_

4  Push the SET button.
The print job is cancelled.

9 Push the READY button.
The READY indicator lights in green and the
message “READY” appears on the printer window
display.

To cancel print data waiting to be printed
Cancel the print job from the Windows spooler window
or the status monitor.

It is not necessary to cancel the print job from the
operation panel of the printer.

Useful Functions

Aligning the Print Position

You can align the print position on one sheet.

1 Display the Sony LPR-1000MD Printing
Preferences dialog box from the Start menu of
Windows.

For detailed information on how to display, see
“Displaying the Printing Preferences Dialog Box
from the Windows Start Menu” on page 15.

2 Click the [@] (Utility) button.

& Sony LPR-1000MD Printing Preferences:

| Main | Layout| Function

Paper Ink:

-
©
TialT) [Auko Shest Feeder - Hlsck e vPA=EL
Paper Size2) [A4 = R |
& Gonmal |
Width(w!) j i Gammal (1]
|
 Banms2)
LenghL)
i  Banmadd
Paper210nm® 237mm
G Medi Typelk] [Sory Hich Qualy Paper =  Gonnstll) ‘
Scalig at 100 %
Stanp{None) —
BB &0 e
(o |

(Utility) button

The Utilities dialog box appears.

Utilities @@

Cleaning Adjust-

@- Head Cleaning |:|§I Print Pasition Adiustment
H =3

Print Test Page

Useful Functions
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3 Click the [Print Position Adjustment] button on the
Adjust group.

Utilities:

Cleaning Addjust

.- Head Cleaning

Print Position &djustment

Print Test Page

[Print Position Adjustment] button

The Print Position Alignment window appears.

4  Enter the numerical value of the amount by which
you want to move the position.

Print Position Alignment

Print Position &lighment

Based on Sheet Direction

Righl [ 0=
Downl¥] ,—U::JJ m

e coeel |

Enter the dimensions.

[Right]: Enter the numerical value of the amount by
which you want to move towards the right in
printers of mm. To move towards the left, attach a —
(minus) before the numerical value.

[Down]: Enter the numerical value of the amount
by which you want to move downward in printers of
mm. To move upward, attach a — (minus) before the
numerical value.

The alignment range to the right is between —100
mm and + 100mm and the alignment range
downward is between —100 mm and +100 mm.

5 Click the [OK] button on the Print Position
Alignment window, and then click the [OK] button
on the Ultilities dialog box.

The Utilities dialog box disappears, and the
window returns to the Printing Preferences dialog
box.

Useful Functions

6 Click the [OK] button on the Printing Preferences
dialog box.
The print position alignment setting is saved.

Advanced Functions

The Function tab allows you to set the following
advanced functions.
* Embedding stamps
You can embed stamps on the printout.
* Sort printing
You can print by volume or by sheet.
* Printing order
You can print from first page to last, or last page to
first.

Function tab

SotC] Stamp

& Callate
Stamp Selting. .

By Shest

Printing O rcer(B)

& FronttaBack

it Ly " Back to Front |
Stanp: (None) il || o

alale elel |

When print settings are performed on a software
application such as word processing or image
processing software, it is recommended that you do not
use advanced functions. The printer may not be able to
print correctly if the settings on the Function tab of the
printer and the settings of the software application
interfere each other. For example, if “Back to Front” is
selected on the print setup window of both application
software and the printer, the two settings will cancel
each other out, and the printing order is first page to last.

Embedding Stamps on the
Printouts

You can embed character strings such as “Confidential”
or bitmap images on the printouts without processing
the printing data. This is called a stamp.

The density of the part of the stamp which lays on the
characters and images printed may be dark.



Adding new stamps

Seven kinds of stamp character strings have already
been registered as defaults.
You can add new stamps using the Add/Remove Stamp
dialog.

1

Click the [Function] tab on the Printing Preferences

dialog box.

Click [Stamp Setting...].

[Stamp Setting...] button

& Sony LPR-1000MD Printing Preferences 2Ix
Main | Lagour | Finetor|
SotiC) Stamp-
15' & Caloe
3 | Stamp Selting...M) I
" BySheet
Pinting Orde®) —————————————
& Frontto Back
Paper.210mm ¥ 297mm
Pattait] Layout " Back foFront
Sealing ratio:100 %
Stamp: (None] - .
6lelal el el
The Stamp dialog box appears.
Stamp [2)%)
1% Embedding Samp(S]
L e Algnmert(E} By Sheet -
 Bimertt)
CNFIDENTE T < oniH) [Cotr =]
Add/Remave Stamp.. (4] Vertcal Position{¥] Center =
e Argle() o
Light Dak
ColorlL) )—

3 Place a check mark in the [Embedding Stamp] box.

[Embedding Stamp]

CINFIDERTIA

¥ [Embedding SlsmplS

@ TeuC)
" Bitmap(B)

| CONFIDENTIAL =l
Add/Remove Stamp...[A] I

Font...(F]

Light Dark

CaloriL)

4 Select the type of stamps which you want to add by
clicking either the [Text] or [Bitmap] radio button.

CINFIDERTIE

¥ [Embedding SlamplS)

1% Tet(C)
" Bitmap(B)

[CONFIDENTIAL |
Add/Remove Stamp... (4] I

Fort. [F)

Light Dark

ColoriL)

[Text] or [Bitmap]

5 Click the [Add/Remove Stamp] button.

CINFIDERTIA

¥ [Embedding SlsmpiS]

@ TeuC)
" Bitmap(B)

| CONFIDENTIAL Bl

| Add/Remove Stamp... (4] Il

Font...(F]

Light Dark

ColorL)

A

[Add/Remove Stamp]

Useful Functions
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The Add/Remove Stamp dialog box appears.

Add/Remove Stamp

Add(a) [

Remowve(D] ]

6 Add a new stamp.

28

When a stamp character string is added:

@ Enter the name of the character string which
you want to add as a stamp in the [Add] text

box.

Enter the name of the stamp character string.

Add/Remove Stamp

| bddd) |

Removell] ]

® Click the [Add] button, and then click the

[Back] button.

The stamp character sting is registered and the
window returns to the Stamp dialog box.

* You cannot register the same character string

twice.

¢ You can register any number of characters,
between one and 60, as a stamp string.

When a graphics stamp is added:

@ Enter the stamp name.

Enter the name of the graphics stamp.

AddfRemove Stamp
|Add@] [LFR-T000MD] | sdd |
Remove(D) ] _f_i Dleh

Useful Functions

® Click the [Add] button.
The Stamp dialog box reappears.

® Specify the bitmap file to be used.
You can specify the bitmap file using the
following two methods.
* Enter the name of the bitmap file in the
bitmap file text box.

¥ Embedding Stamp(S]

" TedtC)
* Bitmap(B]

| LPR-1000MD ~|

Add/Remave Stamp.. (4] ]

File Mame: Browse[R)

NE'\Temp\LPFHDDDMD brn| |

Enter the name of the bitmap file.

¢ Click the [Browse] button.

¥ Embedding Stamp(S]

1 Text[C)
1+ Bitmap(B]

|LPR-1000MD ~l

Add/Remove Stamp... (4] I

File Mame:

[Browse] button

The Select File dialog box appears.



Specify the bitmap file to be used, and then
click the [Open] button.

Select File

Look i [ Temp =~ o B2

A_.E} pn.

1000MD: bip I

My Recent
Documents

Deskiop

My Documents

¥
My Computer
My Network — File game;
Flaces

Open
Cancel

[LPR1000MD brp |
Flescivde: [ bmp =l

Specify the bitmap file.

* You cannot register the same stamp name
twice.

* The number of bitmap files that you can
register is not limited.

* You can register and use are 1, 4, 8 and 24 bit
bitmap data.

Click the [OK] button on the Stamp window.
Click the [OK] button on the Printing Preferences

dialog box.
The settings for a new stamp entry is saved.

Embedding a stamp character string

Seven kinds of stamps such as “CONFIDENTIAL”,
“URGENT”, “DRAFT”, “TENTATIVE”, “SAMPLE”,
“INFORMATIVE” and “PROPOSAL” are registered
already. You can add other character strings as stamps.

1 Click the [Function] tab on the Printing Preferences

dialog box.

Click [Stamp Setting...].

[Stamp Setting...] button

& Sony PR-1000MD Printing Preferences, B3]

Main | Layout | Functon |

Sonc) Stamp
& Collate;
Stamp Selting..[M]
" By Sheet
Piinting Drdet(B])

& Front ta Back
|

© Backto Front |

Paper:21 Omm 237mm
Pl

64 @0l el |
The Stamp dialog box appears.
Stamp. [
7 Ebecding Stane (o]
o] Allgnmeni(E) By Sheet -
" Bitmap(B]
CINFIDENTIA mﬁ Horizontal Position(H) Center i
mj Vetical Posiion(y] Center -
Font. () Anglel) Ot
Light ELS
Cololl) I—

Place a check mark in the [Embedding Stamp] box,
and then click the [Text] radio button.

Place a check mark in the [Embedding Stamp].

Iv Embedding Stamp(S§

" Bitmap(B]

|CONFIDENTIAL B
Add/Remove Stamp...[4] J

Fort...[E)

Light [rark

Color(L]

Select [Text].

4 select the stamp character string to be embedded.

Useful Functions
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Click [V] at the right of the list and select the
desired stamp character string from the list.

Stamp 2R

[V Embedding Stamp(3)

& TeulD)
" Bitmap(B)

Algnment) [eyshesr =]
[CONFIDENT AL (H) [Corter =]
Wetioal Positionfi) [Cemter =]
Angell o

[
Click [¥].

You can embed a new character string as a stamp.
For detailed information on how to add a character

string, see “Adding new stamps” on page 27.

Specify how to embed a stamp by setting each item
in the Stamp dialog.

F jErbecting Sorels)

© TedE) | - JBp Sheet

" Bitmap(E]
[CONFIDENTIAL ——= Horizortal Position(H) {Certer |l
ion (] Center A

G|

INFIDENTIE

Add/Remove Starp. . (&) ‘ Vetical

fnglel)]

(® [Font]: Select a font for the stamp character

string.

You can select any font for the stamp character

string.
Click the [Font] button.

Useful Functions

The Font dialog box appears.

Font E'@
Font: Fant style: Size:
(S [Regular 100 ok |
10 A c | |
[ |l 17 e
H Batang - {Bold 12
T BatangChe Bold Italic 14
() Comic Sans MS 16
() Courier Mew 18
B Dotum ~ 20
—5Sample-
Script:
|Westerm =]

®

Specify [Font], [Font style] and [Size], and then
click the [OK] button.
The Font dialog box disappears.

* You can specify the size other than those
listed by entering the font size directly
between 10 points and 500 points.

* Depending on the font, characters may not be
displayed properly. In such a case, select
another font. Changing a font may allow the
characters to be displayed.

[Color]: Adjusts the brightness of a stamp. You
can adjust the brightness of a stamp in 11 steps.
A stamp becomes lighter toward the Light
direction. A stamp becomes darker toward the
Dark direction.

[Alignment]: You can select the page on which
the stamp is to be embedded from among [First
Sheet Only], [By sheet], and [By Page].

[Horizontal Position] and [Vertical Position]:
Specify the position of which the stamp is to be
embedded. You can select a position from
among nine positions in the horizontal
direction and nine positions in the vertical
direction, 81 positions in total. You can check
the specified position on the Stamp dialog.

[Angle]: Specify the print angle for the stamp.
(You can specify the angle between —90° and
+90°).

Click the [OK] button on the Stamp dialog box after
settings have been completed.
The window returns to the Function tab.



7 Click the [OK] button on the Printing Preferences

Embedding graphic data (bitmap file) as a

dialog box.
The settings for the stamp character string to be
embedded are saved.

stamp

You can use a bitmap file as a stamp by specifying a
bitmap file.

1

Click the [Function] tab on the Printing Preferences

dialog box.

Click [Stamp Setting...].

[Stamp Setting...] button

& Sony LPRAIO0OMD Printing Preferences 22X
| Layout | Pt
Sort(C] Stamp
Stamp Sating...(M]
" BySheet
Printing Order(B)
@ FronttoBack
|
" Back to Front |
Alalslel ol |
The Stamp dialog box appears.
Stamp. )%
& Tedd) P [Boshest =]
" Bitmap(B]
SHFOERTL [CONFIDENTIAL | FE—
@ ) Cerler i
Font iE] Angell) B}
Light Dak
Colorl) —

3 Place acheck mark in the [Embedding Stamp] box,
and then click the [Bitmap] radio button.

Place a check mark in the [Embedding Stamp].

v Embedding Stampl(S)

Add/Remove Stamp.. (&) I

Select [Bitmap].

4 Select the stamp name corresponding to the bitmap
file which you want to be embedded.
Click [V] at the right of the list and select the
desired stamp name of the graphics data to be
embedded from the list.

Stamp

[ Embedding Stamp(s)

 TediC) o =

Click [V].

You can embed a new graphic.
For detailed information on how to add a new
graphic stamp, see “Adding new stamps” on page

217.

Useful Functions
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5 Specify how the stamp is to be embedded by setting
each item on the Stamp dialog.

¥ Embedding Stampl5)
C Te Algrnenie) [y Sheet ~
& BimsplE) =
T — Hoiizontal Posiior(H) Cener ~
AddrRemave Stamp..[4) sion Center ~
00+ 2
il Narne: Biowself) SizelE) i '—\
C:\TempALPR1000MD.bmp DensityD] 1UUj %
o

® [Alignment]: Select the page to which the
stamp is to be embedded from among [First
Sheet Only], [By sheet], and [By Page].

[Horizontal Position] and [ Vertical Position]:
Specify the position at which the stamp is to be
embedded. You can select the position from
among nine positions in the horizontal
direction and nine positions in the vertical
direction, 81 positions in total. You can check
the specified position on the Stamp dialog.

© [Size]: Select the size of a stamp, between 1%
and 100%.

@ [Density]: Specify the density of the stamp
between 0% and 100%.

6 Clickthe [OK] button on the Stamp dialog box after
the settings have been completed.
The window returns to the [Function] tab.

7 Click the [OK] button on the Printing Preferences
dialog box.

The settings for the graphic stamp to be embedded
are saved.

Printing without a stamp
Proceed as follows to print without embedding stamps.

1 Click the [Function] tab on the Printing Preferences
dialog box.

2  Click [Stamp Setting...].

32 Useful Functions

The Stamp dialog box appears.

Stamp. @@

¥ Enbeddng Siampli

[ovshesr <]
[ECI|
IECEE

)
Font..(F) Angiell) s

Light Daik
Colorl)

& Tedid) Hligemeri(P)
 BimesiB)
[CoNFIDENTIAL =

3 Remove the check mark from the [Embedding

Stamp] check box.

Remove the check mark from the
[Embedding Stamp] check box.

W [Embedding StamplS]

& TextC)
" Bitmap(B]

" [COMFIDENTIAL =l
Add/Remove Stamp.. [&] I
Fant...(E]
Light Dark
ColorlL] J

Click the [OK] button on the Stamp dialog box after
the settings have been completed.
The window returns to the Function tab.

Click the [OK] button on the Printing Preferences
dialog box.

Removing stamp entries

You can remove unnecessary stamps using the Add/
Remove Stamp dialog box.

1 Click the [Add/Remove Stamp] button.

The Add/Remove Stamp dialog box appears.



2 Click [¥] on the [Remove] column on the Add/
Remove Stamp dialog.

Add/Remove Stamp

Adde) |

Remove(D] |Maore |__vj

Click [V].

A drop down list appears.

Add/Remove Stamp

Addg) | |
Remova(D) | Printer = Delete

Hone

logo
[

All of the stamp character strings and the names of
graphics stamps are displayed on the drop down
list.

3 Click the stamp which you want to remove.
The stamp name clicked appears.

Stamp name clicked

Add/Remove Stamp

Add(#)
RemovelD] > I Delete J
Back

4  Click the [Delete] button.

A message asking you to confirm that you wan to
delete the stamp appears.

Confirmation for removing a stamp

Delete "Printer?

B  Click the [Yes] button.

»

Click the [Back] button on the Add/Remove Stamp
dialog.
The window returns to the Stamp dialog box.

7  Click the [OK] button on the Stamp dialog box.

You cannot remove the stamps registered as defaults.

Sort Printing

You can print in a set or by sheet using the Function tab
window.

1 Click the [Function] tab on the Printing Preferences
dialog box.

2 Specify [Sort] as follows.

[Sort]

& Sony LPR-1000MD Printing Preferences

| Main | Layoul FL‘

SortiC)

&+ Collste

" By Sheet

Printing Order(B]

& Front to Back

Paper;210mm ¥ 237mm
Portrait] Lagout

Scaling ratio: 100 %
Stamp:[Mane)

" Back to Front

Useful Functions
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Item Comments

[Collate] To print a document consisting of
multiple pages in sets

[By Sheet] To print a document consisting of
multiple pages by sheet

3 Click the [OK] button.
The sort printing setting is saved.

Setting the Printing Order

You can set the printing order.

Saving and Retrieving
Print Settings

You can save print settings as a file.

By retrieving the file in which print settings are saved,
you can set the printer to the desired print settings
quickly and easily.

Saving Print Settings

1 Click the [Function] tab on the Printing Preferences
dialog box.

2  Select the printing order.

1 Perform print settings on the [Main] tab, [Layout]
tab, [Function] tab, and/or the [Print Alignment
Position] window of the Utilities dialog box.

All of items set in those dialog boxes can be saved
as a file.

2 Click the (Save) button on the Printing
Preferences dialog box.

Y Sony LPR-10008D Printing Preferences.

Main | Lapout & F
Sort(C]
* Callate

" By Shest

Printing Order(B]

& Front to Back

Paper; 210mm # 297
Portrait] Lapaut

Scaling ratio: 100 %
Stamp:[Mone]

" Back to Front

[Printing Order]

Item Comments

Front to Back To print from first page to last. The
first page comes at the bottom and
the last page comes on the top.

Back to Front To print from last page to first.
Since the printed sheets are piled up
upwards, the printed sheets are piled
up in the page order (the first page
comes on the top).

3 Click the [OK] button.
The printing order setting is saved.

34 Saving and Retrieving Print Settings

& Sony LPR-1000MD Printing Preferences
Sort(C] Stamp
& Collate
Stamp Setting...(M]
" By Shest
Prinking Order(B)
' Front to Back.
" Back to Front
[B]al = ol of
Cac [l

(Save) button

The Save Settings dialog box appears.

Save Settings

Diefault

MName(M] |

Cancel

3 Name the file in which the print settings will be

saved.



Enter the name in the “Name” text box.

=

Save Settings 2 El

Default

Marme(N] |]Posle|| |

Save Cancel J

Enter the file name.

You can use file names of one to 60 characters. The
number of print setting files that can be saved is not
limited.

Click the [Save] button on the Save Settings dialog
box.

(<)

Save Settinps

Default

Mame{h] JPnstad

[Save] button

Settings performed on the [Main] tab, [Layout] tab,
[Function] tab, and the [Print Alignment Position]
window of the Utilities dialog box are saved as a
file and the Save Setting dialog disappears.

Settings made for adding new stamps and removing
stamp entries are not included in the file.

Changing the Print Settings

You can change some parts of print settings saved as a

file.

1

Re-enter the value for the print settings you want to
change on the [Main] tab, [Layout] tab, [Function]
tab and/or the [Print Alignment Position] window

of the Utilities dialog box.

2  Click the (Save) button on the Printing

Preferences dialog box.
The Save Setting dialog appears.
The names of files currently saved are listed.

=)

Save Settings

Diefault
Poster

MName[M] I

3k Cancel

Click the file containing settings you wish to
change.

The name of the file selected is displayed in the
Name text box.

(=

Save Settings

Disfault

MName[M] IF’ﬂster

Save Cancel

4  Click the [Save] button on the Save Settings dialog

box.
A confirmation message appears.

Confirmation for overwriting settings

Overwrite "Poster”?

B Click the [Yes] button.

The settings of the file selected in step 3 are
changed to the settings changed in step 1.

Saving and Retrieving Print Settings
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You cannot change default print settings.
For detailed information on default print settings, see
“Setting Items for the Printer Driver” on page 65.

Retrieving the Print Settings Saved

You can retrieve the print settings any time.

1 Click the (Retrieve Settings) button on the
Printing Preferences dialog box.

& Sony LPR-1000MD. Printing Preferences 2Ix

son(c) Stamp

@ Callste
Stamp Setting. (M)

By Sheet

Piinting 01cer(B)

@ FranttaBack

 Back toFront

alolelel el

=N

(Retrieve Settings) button

The Retrieve Settings dialog box appears.

Retrieve Settinps @

Drefault
Poster

Name(}]

Cancel

2  Click the file name you wish to retrieve from the
list.

36 Saving and Retrieving Print Settings

The file name is displayed in the Name text box.

Hetrieve Settings Elrgl

Default

Name(M] |IPDSIEI |

Retrieve I Delete: I Cancel I

The file name selected in step 2 is displayed.

3 Click the [Retrieve] button.
The Retrieve Settings dialog disappears. The
printer switches to the print settings retrieved.

Settings for adding and removing stamps are not saved.

Resetting the print settings to default
settings

1 Click the (Retrieve Settings) button on the
Printing Preferences dialog box.

2 Select “Default” from the list.

Retrieve Settings i‘@l
g O
Harrg[N) JDelauIt
Retieve | O Cancel

Select “Default.”

3 Click the [Retrieve] button on the Retrieve Setting
dialog box.
The printer changes in default settings status.
For detailed information on default settings, see
“Setting Items for the Printer Driver” on page 65.



Deleting Unnecessary Print
Settings

1 Click the (Retrieve Settings) button on the
Printing Preferences dialog box.
The Retrieve Settings dialog appears.

Retrieve Settings. @@

Default
Paster

MNamelt] I

Cancel

2  Click the file name which you wish to delete on the
list.
The selected file name is displayed in the Name text
box.

Retrieve Settings

D efault

Mameft] |IF‘oster |

Retrieve I Delete: J Cancel I

The file name selected in step 2 is displayed.

3 Click the [Delete] button.
A confirmation window appears.

Confirmation for deleting settings

Delete "Poster'?

4  Click the [Yes] button.
The file selected in step 2 is deleted.

Saving and Retrieving Print Settings
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Using the Status Monitor

The printer allows you to monitor the printer status via a

USB connection. This is called the status monitor.

The status monitor has the following functions.

* Displaying the current printer status and job
processing status (page 38)

* Displaying the ink level (page 38)

* Displaying error messages (page 55)

* Pausing printing or cancelling printing by opening the
Windows spooler window (page 38)

uondund JOHUoN
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Displaying the Status Monitor

When executing a print command, the status monitor
starts automatically and the [i] icon appears on the task
bar.

When you double-click the [iJ icon, the status monitor
appears.

When printing is completed, the status monitor
automatically disappears.

Status monitor

LPR-1000MD Status Monitor X

Ink Lewvel

o .
I ol L]
GL EL
Status
Mo printing

Error

Mo abnomalities.

- Make sure the printer thows "READY".
- Click "Cancel Print Job" button below to carcel

ol
- Repiint this job aftei the printer "READY"!

Cancel Print Job ||

Using the Status Monitor

Confirming the Ink Level

Display the status monitor by double-clicking the [i]
icon.

The ink level is displayed at the right top corner of the
window.

GL (Gray)

BL (Black)

[rk Level

GL BL

How to check the ink level

The number of squares indicates the remaining amount
of the ink.

HEE : The ink level is sufficient.

HME[ | : Theink level is 10 to 50%.

B[ [ ] : The ink level is less than 10%. With the
remaining amount of ink, about 100 sheets can be
printed. Prepare a new ink cartridge.

[ 1 : The ink level is 0%. The ink has run out.
Replace the ink cartridge.

For detailed information on how to replace the ink
cartridge, see “Replacing the Ink Cartridges” on page
43.

Controlling the Print Job

The status monitor allows you to monitor and control the
print job.

When the monitor is displayed, the printer status is
displayed.



1 Click the [Job] button.

Status

Mow printing.

Eror

Ma abnomalties

- Make sure the printer shows "READY"".
- Click. "Cancel Print Job" button below to cancel

ol
- Reprint thiz job after the printer "READY"".

Cancel Print Job

I
Click the [Job] button.

The Windows spooler window appears.

&’ Sony LPR-1000MD

Subr
S:00)

Printer Document View Help

Document Mame Status Cwrier Pages Size.

] Test Page Printing User 1 72 bytes/113 KB
dl |
1 document(s) in queue

Right-click the name of the job you wish to control.
A drop down list appears.

& Sony L PR-1000MD
Prinker Document  Yiew Help
Document Mame Status Owner Pages Size Suh;
Printing User 1 72bytes/113KE  8:05;
| Pause
Restart
| | Properties 3
Cancels the selected documents.
Select the desired item.
Item Comments
Pause To pause printing
Restart To reset the printer so that it is ready

to print (ready status)

Cancel To cancel the print job

Using the Status Monitor
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Maintenance

Cleaning the Head

Clean the printer head when it is dirty, or whenever a test

printing indicates it is necessary.

Since the head cleaning consumes ink, perform the head

cleaning only when necessary.

You can clean the head with either one of the following

two methods:

* Cleaning the head from the printer driver (page 40)

* Cleaning the head from the operation panel of the
printer (page 41)

Cleaning the Head from the Printer
Driver

When there is a print job left to be done, the head
cleaning is not performed. Start cleaning the head after
the printing of the current job is completed.

1 Display the Sony LPR-1000MD Printing
Preferences dialog box according to the operation
procedure of “Displaying the Printing Preferences
Dialog Box from the Windows Start Menu” on page
15.

N

Click the (Utility) button.

& sony LPR-1000MD.Printing Preferences:

Main | Layout | Funetion
Paper ik
-_—
@
TraulT) [Aute Sheet Feeder - Black and Wrhite(B]
Papersizel [0 =] Garma Type
10 & Ganmal
Width{w) = Gammal(l]
" Gamma2(2)
LengthiL)
=i © Gamma3(3)
Paper:210mm ¥ 237mm
P :vaMLay b Media Typelk) |Sony High Qualty Paper ~  Gamnadt)
Scaling ratio:100 %
Stamp. [None] N
B B &6 e
Corcll ) [aoy

(Utility) button

Cleaning the Head

The Utilities dialog box appears.

Utilities

Cleaning Adjust-

Head Cleaning

Print Pasition &djustment

Print Test Page

3 Click the [Head Cleaning] button.

[Head Cleaning] button

Urilities

Cleanirg Adijust

.»H Head Cleaning

PFrint Position &djustment

Print Test Page

The printer starts cleaning the head.
It takes one minute to one minute and 30 seconds to
clean the head.

When the head cleaning is completed

Check the result of the head cleaning by printing a test

page.

For detailed information on test printing, see “Printing a
Test Page” on page 42.

If stain or smudges remain on the test sheet, repeat the

head cleaning until the stain disappears.

If the printer cannot print a test page, the ink may have
run out. Replace the ink cartridge.

For detailed information on replacing the ink cartridge,
see “Replacing the Ink Cartridges” on page 43.



Cleaning the Head From the
Operation Panel

B [ ] |e=lrad

5 Printer window display 2

1 Push the MENU button.
The READY indicator goes off and the message
“Ink level” appears.

2  Pushand hold the MENU button or »¥ button until
the message “Cleaning.” appears on the printer
window display.

Cleaning.

3 Push the SET button.

’

The message “Clean?/Yes_" appears.
Clean ?
Yes_

4 Push the SET button.
The printer starts cleaning the head.
When the printer is cleaning the head, the following
message appears.

Now cleaning
nead.

When the printer finishes cleaning the head, the
message “Cleaning.” appears again.

5 Push the READY button.
The READY indicator lights in green, and the
message “READY” appears on the printer window
display.

When the head cleaning is completed

Check the result of the head cleaning by printing a test
page.

For detailed information on test printing, see ‘“Printing a
Test Page” on page 42.

If stains or smudges remain on the test sheet, repeat the
head cleaning until the stain disappears.

If the printer cannot print a test page, the ink may have
run out. Replace the ink cartridge.

For detailed information on replacing the ink cartridge,
see “Replacing the Ink Cartridges” on page 43.

Cleaning the Head
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Printing a Test Page

Print a test page for checking whether the ink jets from

the nozzle of the head cartridge or the print position has

shifted.

You can perform a test printing using either of the

following two methods:

* Test printing from the printer driver (page 42)

* Test printing from the operation panel of the printer
(page 42)

Printing a Test Page from the
Printer Driver

When there is a print job left to be done, the test printing
is not performed. Start the test printing after the printing
of the current job is completed.

1 Display the Sony LPR-1000MD Printing
References dialog using the procedure explained in
“Displaying the Printing Preferences Dialog Box
from the Windows Start Menu” on page 15.

2 Click the [@ (Utility) button.

& Sony LPR-100OMD Printing Preferences

[Man [ Layout | Functin

Paper i
Trau(T] [ato SheetFssder  +]
Paper Sizelz] |Ad -

Width(w) j o & Gammal(l)

e A

-_—
@ Black and White(8)

 Bamma3g)

Media Typelk) |Sony High Quality Paper -  Gammadld) ‘
Al el,ﬂjlo 8|
T

(Utility) button

Printing a Test Page

The Utilities dialog box appears.

Utilities

Cleaning Adjust-

@- Head Cleaning 2| Pt Pasiion Adustmert

Print Test Page

3 Click the [Print Test Page] button.

.Ulilities @@

Cleaning Adjust

@ Head Cleaning

PFrint Position &djustment

Print Test Page

[Print Test Page] button

The printer starts printing a test page.

4  Check whether there are any uneven spots or any
blank spots.

Printing a Test Page From the
Operation Panel

1 34
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5 Printer window display 2




1 Push the MENU button.
The READY indicator goes off and the message
“Ink Level” appears.

2  Pushand hold the MENU button or »» button until
the message “Print test page.” appears on the printer
window display.

Print test

page.

3 Push the SET button.
The message “Test print?/Yes_" appears.

Test print?
Yes

4 Ppush the SET button.
The printer starts printing a test page.
While the printer is printing the test page, the
following message appears.

Print test page.
Test printing,

When the printer finishes printing the test page, the
message “Print test page./Test printing.” appears
again.

5 Push the READY button.
The READY indicator lights in green, and the
message “READY” appears on the printer window
display.

6 Check whether there are any uneven spots or any
blank spots.

Replacing the Ink
Cartridges

When the ink runs out, proceed as follows to replace the
ink cartridges.

Recommended Ink Cartridges (not supplied)

Color Product name
Black EPI-L100BL Sony Ink Cartridge
Gray EPI-L100GL Sony Ink Cartridge

Notes on using the ink cartridge

* Be sure to remove the protective cap before using a
new ink cartridge. If you don’t, you cannot load the
ink cartridge correctly in the printer.

* Load the ink cartridge in the printer promptly after you
remove the protective cap. If dust accumulates in the
ink cartridge, this may choke the print head and cause
a malfunction of the printer.

* Do not close the air hole located on the top of the ink
cartridge. If the air hole is covered, the ink cartridge
cannot spray the ink and this may cause a malfunction.

Air hole

e Itisrecommended that you use the ink cartridge by the
recommended date noted on the carton of the ink
cartridge. To maintain the best print quality, use up the
ink cartridge within six months of opening it.

* If you refill the ink cartridge or modify it, we will not
guarantee its operation.

* Be sure not to remove or load the ink cartridge except
when replacing it.

* Be careful not to injure your fingers with pins when
changing the ink cartridge.

* Replace the ink cartridge when the printer is turned on
(the ON/STANDBY indicator is lit in green).

Replacing the Ink Cartridges
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1 Open the head cover.

44

Head cover

Do not push the head cover backward after it has
been opened a little. If extra force is applied at the
hinges of the head cover, it may be hard to open it
from then on.

Remove the empty ink cartridge.

Pull it up by holding the handle of the ink cartridge.

Do not touch the points marked with ﬂ .
If you touch those points, the ink may get on your
fingers.

Replacing the Ink Cartridges

3 Remove the protective cap from the new ink
cartridge.

Do not touch the points marked with ﬂ .
If you touch those points, the ink may get on your
fingers.

Check that the air hole located on the top of the ink
cartridge is open.

A

4 Matching the protruding part placed on the right
side of the ink cartridge with the groove of the



printer, insert it horizontally until the ink cartridge
and the head cartridge line up.

Head cartridge

Load the remaining ink cartridges using the same
procedure, matching the ink cartridge and its proper
location.

BL

GL

\y
/

Location Ink cartridge

BL Black, EPI-L100BL Sony Ink
Cartridge

GL Gray, EPI-L100GL Sony Ink
Cartridge

5 Close the head cover.

* If the head cartridge and/or ink cartridge are not
loaded correctly, you cannot close the head cover.
If you cannot close the head cover, check that the
cartridges are loaded correctly.

* Insert the ink cartridges that flush against the top
of the head cartridge without allowing them to
move about. If they are not inserted securely, the
unit may not print correctly because the ink
cartridges are crooked. Also, even if the
remaining ink is sufficient, the message “Ink
depleted” may appear. Before replacing the ink
cartridge, check the remaining amount of ink. If
there is enough left, insert the same ink cartridge
again without replacing it.

6 Push the READY button.
The READY indicator lights in green, and the
message “READY” appears on the printer window
display. Now the printer is ready to print.

Used ink cartridges and head cartridges are a mixture of
plastic, metal, and ink. Put them in a plastic bag and
throw them away as incombustible waste.

Replacing the Ink Cartridges

45

o ‘HHHHHHHHHH



Soueusuleiy

46

Replacing the Head
Cleaning Roller

This section explains how to replace the head cleaning
roller.
Use an EPA-5CR head cleaning roller (not supplied).

* When replacing the cleaning roller, keep the power of
the printer on. Before replacement, be sure to remove

the auto sheet feeder tray.

When replacing the cleaning roller, be careful of ink
stain around the head cleaning roller and the head
cleaning unit. The ink may stain your hands and
clothes.

We recommend that you put on gloves when replacing

the cleaning roller.
Do not press buttons on the printer during
replacement.

1 Remove the auto sheet feeder tray.

2 Push the MENU button.

The READY indicator goes out and the message
“Ink level/Black (BL)” appears on the printer
window display.

on the printer window display.

Replace roller.

Replacing the Head Cleaning Roller

Push the MENU button or the <¢</P¥» button and
hold it until the message “Replace roller.” appears

4 Push the SET button.

}

The message “Replace?/Yes_" appears on the

printer window display.

Replace?
Yes_
Culrsor

If the message “Replace?/No_" appears
Display “Yes_” by pressing the <¢</»¥» button,
and then push the SET button.

Push the SET button.

The message changes from “Warming up” to
“Ready to replace”, and then, after several seconds,
the message “End?/Yes” appears.

While the cleaning roller is being replaced, the
message “Ready to replace.” or “End?/Yes.”
appears.

At this time, do not open the main cover. If you
open the main cover, this may cause the printer to
malfunction.

Remove the used head cleaning roller in use as
follows.

(® Put on the glove supplied with the head
cleaning roller.




(@ Slide the two tabs in the direction of the arrows @ Press the roller ejector © into the metal parts at
(A). both ends of the roller straight down until it
clicks.

(® Insert the unit ejector B horizontally in the
direction of the arrow until it clicks.

* The cleaning roller may come off;, if it is not
caught securely. Be sure to press the roller
ejector until it clicks.

* To prevent the cleaning roller from being
deformed or stained, do not touch the white
part of the cleaning roller.

@ Rotate the roller ejector in the direction of the
arrows, and unlock the cleaning roller.

@ Pull the unit ejector toward you to remove the
head cleaning unit ®.

Hold the parts of the roller ejector indicated
with the arrows.

Do not leave the printer without the head
cleaning unit for a long period of time. When
the head cleaning unit is removed, do not open
the main cover of the printer or insert your hand
into the inside of the printer.

7  Remove the head cleaning roller from the head

cleaning unit, and then attach the new head
cleaning roller.

Replacing the Head Cleaning Roller 47
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® Insert the new head cleaning roller ® until it
clicks at both ends.

The cleaning roller may come off it is not fully
inserted.

8 Replace the head cleaning unit in the printer.

@ Slide the two tabs in the direction of the arrow
(B).

® Insert the head cleaning unit with the unit
ejector attached into the printer horizontally as
far as it will go until it clicks.
After it is inserted, push it in at two points so
that it can not move around inside the unit.

Replacing the Head Cleaning Roller

If it is not inserted completely, the unit cannot
clean the head properly.

(® Pull the two claws at the bottom of the unit
ejector downward, and remove the unit ejector
horizontally.

9 After confirming that the message “End?/Yes_" has

appeared, push the SET button.
The printer starts cleaning and the message “Now
cleaning head.” is displayed.

Now cleaning
head.

When the printer finishes cleaning, the message
returns to ‘“Replace roller.”

10 Push the READY button.
The READY indicator lights in green and the
message “READY” appears on the printer window
display.
The head cleaning roller replacement is completed.

11 Attach the auto sheet feeder tray as it was.



* Do not reuse the head cleaning roller once it is
removed from the printer, as foreign material on the
head cleaning roller may cause clogging of the printer
head.

* Dispose of the used head cleaning roller with the roller
ejector attached, and throw away the unit ejector and
the gloves, too.

* The head cleaning roller is a mixture of plastic, metal
and ink. Dispose of it as incombustible waste,
observing local rules and regulations.

Replacing the Head Cleaning Roller
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Miscellaneous

Precautions

Safety

* Operate the printer using the power source specified in
“Specifications” on page 59.

* Be careful not to damage the AC power cord by

placing or dropping heavy objects on it; it is dangerous

to use the printer with a damaged AC power cord.

If you do not intend to use the printer for a long time,

disconnect the AC power cord.

Unplug the AC power cord by grasping the plug, not

the cable itself.

Do not disassemble the printer.

Do not remove the cover. There is a danger of electric

shock from the internal parts.

* Be careful not to spill water or other liquids on the

printer, or to allow combustible or metallic material to

enter the cabinet. If used with foreign matter in the

cabinet, the printer is liable to fail, or present a risk of

fire or electric shock.

Ventilation holes are provided to prevent the printer

from overheating. Be careful not to obstruct them with

other printers or by covering the printer with a cloth,

etc.

If the printer malfunctions or if a foreign body falls

into the cabinet, disconnect the AC power cord

immediately and consult your dealer.

Handling the Printer

When handling the printer for assembly and so on, pay

attention to the following:

* The printer is heavy. When lifting the printer, be
careful not to hurt your back.

* When lifting the printer, put your hands under the
bottom of the printer from both sides and pick it up
horizontally.

Precautions

* Be sure not to lift the printer by paper outlet or head
cover. If you do so, these parts may break, or the
printer may fall and this may cause injury.

* When putting the printer down, put the back feet of the
printer first, and then put the front feet down slowly.

Installation

The printer is a precision instrument which contains
liquid ink.
* Place the printer in a location which meets the
following conditions:
—10°C to 35°C (50°F to 95°F) temperature and 20 to
80% humidity
— horizontal (within £2.0°) and stable
* If you place the printer on a slanted surface, the printer
may not print correctly because the ink will spray out
at an angle.
* To protect the printer from damage, place it:
— Away from slippery surfaces
— Away from mechanical vibration
— Away from excessive dust
— Away from extremely hot or cold wind
— Away from direct or excessive sunlight
— Away from water or other liquids.
— Do not cover the printer with a cloth, etc. and place
it in a location with good ventilation.
* Place the printer so that the four feet of the printer are
on a flat surface. If you place the printer at a slant, the
paper may not feed correctly.



Attention-when the product is installed in Rack:
1.

Place the printer keeping spaces towards the back,
front, left, and right, and a space over the top as shown
in the following diagram.

I100m

10cm 10 cm
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— Ventilation holes are provided on the back of the
printer. Keep the back of the printer 10 cm or more
away from the wall.

— Keep the front of the printer clear for 20 cm or more
for loading or ejecting paper.

— Keep the top of the printer clear for 25 cm or more
for loading ink cartridges or removing jammed

paper.

Prevention against overloading of branch circuit
When this product is installed in a rack and is
supplied power from an outlet on the rack, please
make sure that the rack does not overload the supply
circuit.

Providing protective earth

When this product is installed in a rack and is
supplied power from an outlet on the rack, please
confirm that the outlet is provided with a suitable
protective earth connection.

Internal air ambient temperature of the rack

When this product is installed in a rack, please make
sure that the internal air ambient temperature of the
rack is within the specified limit of this product.

4. Prevention against achieving hazardous condition
due to uneven mechanical loading
When this product is installed in a rack, please make
sure that the rack does not achieve hazardous
condition due to uneven mechanical loading.

5. Install the equipment while taking the operating
temperature of the equipment into consideration
For the operating temperature of the equipment, refer
to the specifications on page 59.

6. When performing the installation, keep the rear
of the unit 10 cm (4 inches) or more away from
walls in order to obtain proper exhaust and
radiation of heat.

Before Moving the Printer

* Remove the AC power cord from the printer.
* Move the printer with the ink cartridge loaded.
* Hold the printer horizontally and be careful not to give

vibrations to the printer. Doing so causes leakage of
the ink.

Before Transporting the Printer

* Remove the ink cartridge.

¢ Insert the yellow rubber cap and the dummy pack
removed from the ink feeding inlets when setting up
the printer. Insert the dummy pack into the center ink
feeding inlets so that the side onto which the labels
attached faces to the left.

SR
Dummy pack
Yellow rubber
cap

N

\,‘% >

!
d
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 Retain the head cartridge inside the printer without
removing.

Precautions
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* Pack the printer using the original carton and packing

materials supplied with the printer when you
purchased the printer.

Before Asking Repairment

Remove the ink cartridge from the printer.

Insert the yellow rubber cap and the dummy pack
removed from the ink feeding inlets when setting up
the printer. Attach the dummy pack into the center ink
feeding inlets so that the side onto which the labels
attached comes to the left side.

Retain the head cartridge inside the printer without
removing.

When Not Using the Printer for
Long Periods

Remove the AC power cord from the printer.

Keep the printer with the ink cartridge loaded. If you

remove the ink cartridge, the ink inside the ink

cartridge may dry up. This may cause the print head to
clog. If you retain the ink cartridge removed from the
printer, cover the ink feeding inlets with the yellow
rubber caps and the dummy pack removed when
setting up the printer after unpacking.

Avoid placing the printer in a location subject to:

— excessive dust. Since many precise nozzles are
located on the head, excessive dust may cause to
choke the head.

— extremely high or low temperatures. This may cause
these nozzles to clog up.

— mechanical vibration

— Do not put the printer on a slanted surface. If you
place the printer on a slanted surface, this may cause
leakage of the ink.

If you do not intend to use the printer for a long period,

it is recommended to put a cover over the printer.

Troubleshooting

Troubleshooting

The following troubleshooting checks will help you
correct the most common problems you may encounter
with your printer. Before proceeding with these trouble
checks, first check that the power cord is firmly
connected. Should the problem persist after you have
applied the remedy suggested below, unplug the printer
and contact your dealer.

Symptoms

Possible causes and remedies

The printer is not
turned on. (The ON/
STANDBY indicator
does not light in
green.)

* The main power switch located on

the back of the printer is not set to

ON.

— Set the main power switch to
ON. (page 9)

* The power cord connection may not
be correct.

— Check the connections and
rectify, if necessary. (Refer to
“Turning the Printer On”
described in the printed Setup
Manual.)

— Check whether power is supplied
to the wall outlet.

The printer does not
ready itself to print.
(ON/STANDBY
indicator blinks or is
lit in orange.

An error message is displayed on the

status monitor or printer window

display.

— Take remedies according to the
message. (page 54)

The ON/STANDBY
indicator is lit in
green and the
READY button is lit
in orange.

Proceed as follows to correct:

@ Push and hold the ON/STANDBY
button for three seconds.

© After the ON/STANDBY indicator
turns to orange, push the ON/
STANDBY button again.

If the ON/STANDBY and READY

indicators do not light in green,

disconnect the AC power cord and try

to perform the above operations again.

If the printer does not start even after

you take the above remedies, the printer

is malfunctioning. Contact your dealer.

Printing does not
start.

* Anerror message is displayed on the
status monitor.
— Take remedies according to the
message. (page 54)
* The main power switch is set to off.
— Set the main power switch to on.
(page 9)
¢ Neither the ON/STANDBY
indicator nor the READY indicators
are lit in green.
— Turn both the ON/STANDBY
indicator and the READY
indicator to green. (page 10)




Symptoms

Possible causes and remedies

Symptoms

Possible causes and remedies

Paper in the auto
sheet feeder tray is
not fed.

e The printer is not in print mode.

— Check the status of the ON/
STANDBY and READY
indicators, and turn both the ON/
STANDBY indicator and the
READY indicator to green.
(page 10)

* Paper is not loaded.
— Load paper. (page 12)

¢ The paper guides (vertically and
horizontally) are not correctly set.

— Set them correctly. (page 12)

¢ Too much paper is loaded.

— Do not exceed the number of
sheets which the automatic paper
feed tray can hold. (page 11)

*  Warped paper is being used.

— Try to make the warped paper lie
flat and load it again. (page 12)

* Folded or wrinkled paper is being
used.

— Do not use folded or wrinkled
paper. (page 12)

» Paper is stacked improperly.

— Riffle the paper and load it again.

* The printer is not placed on a flat
surface.
—Place the printer on a flat surface.
(page 50)
* Anerror message is displayed on the
printer window display.
— Take remedies according to the
message. (page 54)

The last sheet of

paper cannot be fed.

It is often difficult to feed paper from

the automatic paper feed tray, or

sometimes it may be fed at an angle,

depending on the circumstances.

— Add one sheet of the same type of
paper to the automatic paper feed
tray and try to print again. (page 13)

The printed surface is
dirty.

¢ The paper path system may be dirty.
— Open the top cover and wipe the
plastic surface gently with a
cotton swab to remove the dust.

Do not use alcohol.

* The life span of the head cleaning
roller may have run out.

— Try head cleaning two or three
times and print a test page. If the
printed surface is still dirty,
replace the head cleaning roller.
(page 46)

* The ink of the printout just ejected is
smeared on the ejected paper.
—The next printout is ejected

before the previous printout is

dry and its printed surface may
be dirty. In such a case remove
the ejected printout one by one
from the auto sheet feeder tray.

The surface of
printouts is dirty,
especially the
beginning of the
printed surface.

The life span of the head cleaning roller

may have run out.

— Try head cleaning two or three times
and print a test page. If the printed
surface is still dirty, replace the head
cleaning roller. (page 46)

The printout is
smeared or smudged.

« Unsuitable paper is being used.

— Use suitable paper. If you use
paper except other than that
recommended, this may cause
the ink to spray unevenly or run.
(page 11)

¢ The amount of ink is excessive for
the paper in use.

— The paper loaded in the auto
sheet feeder tray is different from
the media type specified in the
Printing Preferences dialog box.
Specify the correct media type. It
is recommended to use the paper
manufactured by Sony
Corporation. (page 17)

The printout is blurry,
or white stripes or
scorches appear. Or
there is a part which
is not printed.

The print head is dirty.

—Try head cleaning two or three times
and print a test page. (pages 40 and
42) If the printed surface is still
dirty, consult your dealer.

Troubleshooting
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Symptoms

Possible causes and remedies

Back to front printing
cannot be done.

The setting of the printer and the print
settings of the application software
interfere with each other.

— Deactivate “Back to Front” item on
the Printing Preferences dialog box
of the printer or the print setup
dialog box of the software
application.

Printing multiple
pages per sheet
cannot be done.

The setting on the layout tab and the
print settings of the application
software interfere each other.

— Deactivate “Printing multiple pages
per sheet” item on the Printing
Preferences dialog box of the printer
or the print setup dialog box of the
software application.

Error Messages

Error Messages

On the printer window display, warning messages
recommending the replacement of consumable parts or
warnings stating the causes of errors, or error messages

are displayed.

Error messages are also displayed on the status monitor.
Take steps to remedy troubles or prepare the
replacement of used or worn out products.

Warning Display

The printer monitors the life span of consumable parts
and warning messages that state the time for
replacement is coming is displayed.

When such warning messages appear, prepare the
replacement parts. However, you can continue printing.

Warning message

Possible causes/remedies

READY/Ink low xx®

The amount of ink left is less than
10%.
— Prepare a new ink cartridge.

(page 43)

READY/Roller full

The head cleaning roller is almost

used up.

— Replace the head cleaning roller.
(If you do not replace it, the top
part of the paper becomes dirty
when printed. (page 46)

READY/Drain sheet
full

The head cleaning unit is almost used

up.

— Replace the head cleaning unit. (If
you do not replace it, the top part
of the paper becomes dirty or
color mixture may occur when
printed.) For detailed information
on the optional head cleaning unit,
contact your dealer.

READY/Absorber full

The waste ink absorber is full.

— Contact your dealer. (If you
continue to use the printer without
replacing the waste ink absorber,
printouts may be dirty.)

a) xx means the last alphabetic characters of the
message. These indicates the color and location of
the ink. For detailed information, see “Replacing the
Ink Cartridges” on page 43.

Error Messages

If a problem occurs, an error message is displayed on the
printer window display and on the status monitor.

Take remedies according to the message.

Error messages are displayed as follows.



Printer window display

Out of paper

Status Monitor

LPR-1000MD Status Monitor X

Ink Level

L]
GL EL
Status
MHaw printing.
Errat

Mo abmormalities:

- Make sure the printer shows "READY"",
- Click "Cancel Print Job" button below to cancel

ol
- Reprint this job after the printer "READY"!

Cancel Print Job i

In the following table, the upper error messages are
displayed on the printer window display and the lower
error messages are displayed on the status monitor.

After removing the causes of errors

Push the READY button so that the printer is reset to
print mode (both ON/STANDBY and READY
indicators light in green).

Errors related to paper

Error message

Causes/remedies

Out of paper
(Auto sheet feeder try is
empty.)

Paper is not loaded in the auto

sheer feeder tray.

—Load paper in the auto sheet
feeder tray. (page 12)

The auto sheet feeder tray is not

set correctly.

— Check that the auto sheet
feeder tray is completely
inserted. (Refer to “Attaching
the Auto Sheet Feeder Tray”
described in the printed Setup
Manual.)

Wrong paper size
(Paper size does not
match up with paper
size setting.)

The printer has been designed to use
size A4 paper. Do not use paper other
than size A4 paper.

Paper feed error
(A Paper Feed error has
occurred.)

The printer is not in print mode.
— Make the ON/STANDBY and
READY indicators light in

green. (page 10)

The Auto sheet feeder tray is

empty.

— Load the paper. (page 12)

Paper other than size A4 paper is

loaded.

— Be sure to use size A4 paper.

The paper guides (vertically and

horizontally) are not correctly set.

— Set them correctly. (page 12)

Too much paper is loaded.

— Do not exceed the number of
sheets which the automatic
paper feed tray can hold.
(page 11)

Warped paper is being used.

— Try to make the warped paper
lie flat and load it again.
(page 12)

Folded or wrinkled paper is being

used.

— Do not use folded or wrinkled
paper. (page 12)

Paper is stuck.

— Riffle the paper and load it
again. (page 12)

The printer is not placed on a flat

surface.

—Place the printer on a flat
surface.

Paper jam
(Paper jam)

The paper is jammed.
— Remove the jammed paper.

(page 56)

Error Messages
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Errors related to ink

Error messages Causes/remedies

Error messages Causes/remedies

Ink depleted xx a) ¢ The amount of ink is low.

(xx ink has run out.) — Replace the ink cartridge.

(xx ink cartridge is not (page 43)

attached.) ¢ The ink cartridge is not set
correctly.

— Check and set the ink cartridge,
if necessary. (page 43)

e The head cartridge is not set
correctly.

— Check and set the head
cartridge, if necessary. (Refer
to “Attaching the Head
Cartridge” described in the
printed Setup Manual.)

The head cleaning unit is not

attached.

— Attach the head cleaning cartridge.
(Refer to “Attaching the Head
Cartridge” described in the printed
Setup Manual.)

Cleaning unit/is not
attached.

a) xx means the last alphabetic characters of the
message. These indicates the color and location of
the ink. For detailed information, see “Replacing
the Ink Cartridges” on page 43.

Error related printer status

Error messages Causes/remedies

The temperature of the head or of the

inside of the printer rises.

— This is not a malfunction. Wait for
a while. If the room temperature is
high, the printer may run hot. Be
careful about the room

Cooling down

temperature.
Head cartridge/is not The head cartridge is not attached
attached correctly.
(The print head — Confirm whether the head
cartridge is not cartridge is attached correctly.
attached.) (Refer to “Attaching the Head
Cartridge” described in the printed
Setup Manual.)
Head cover/is open * The head cover is open.

(The print head cover is — Close the cover firmly.
open.) * The head cartridge lock screws are
not tightened securely.

— Check them and tighten them
securely. (Refer to “Attaching
the Head Cartridge” described
in the printed Setup Manual.)

* The harness of the head cartridge
cable is not pushed in to the
groove securely.

— Push the harness of the head
cartridge cable into the groove
securely. (Refer to “Attaching
the Head Cartridge” described
in the printed Setup Manual.)

Main cover/is open The main cover is not closed.

(The main cover is — Close the main cover until both

open.) left and right eject buttons click
and lock.

Error Messages

Cleaning unit/is not The head cleaning unit is not inserted
closed. securely.

— Open the main cover by pushing
both left and right eject buttons
and push the head cleaning unit
until it is seated properly. (Refer to
“Attaching the Head Cleaning
Unit” described in the printed
Setup Manual.)

Print data error occurs.

Remove the print data error.

— Cancel the print job when the print
data is left in the spooler.

(page 23)

— Push the READY button.

— If the printer does not recover even
when you push the READY
button, push and hold the ON/
STANDBY button for about three
seconds so that the printer is in
standby mode. Then push the ON/
STANDBY button again so that
the printer is set to on. If the
printer does not recover even after
you push the ON/STANDBY
button, set the main power switch
located on the back of the printer
to the off side, and then turn the
printer on again.

A print data error/has
occurred.
(Print data error.)

Malfunction/xxx The printer is in need of repairment.
Consult your dealer. xxx indicates the
error code. If you write the code on
the status column of “Customer
Confirmation Sheet,” the service
personal understand the nature of the

problem.

If the Paper Jams

When the paper jams, the error message “Paper jam”
appears on the printer window display. Remove the
jammed paper following the steps below.

When you put your hands inside of the printer, be careful
not to hurt yourself by touching hot or sharp parts.

Ejecting the jammed paper automatically

Push the READY button on the printer. The jammed
paper is ejected automatically.

When the jammed paper is not ejected and the message
“Paper jam” does not disappear on the printer window
display even though you push the READY button,
proceed as follows to remove the jammed paper.



When the paper fed from the auto sheet 4  Ppushboth the right and left eject buttons to open the
feeder tray stops halfway main cover.

1 Remove the auto sheet feeder tray, and check
whether or not the paper has jammed near the back.

2 Ifthe jammed paper can be easily removed, pull the
jammed paper out slowly.
If you cannot remove the jammed paper from the
outside, remove it according to instructions in step,
and after, in “When the paper is jammed inside the
printer.”

When the paper is jammed inside the
printer

Eject buttons

1 i you can remove the jammed paper from the
feeding input or output slot, pull the jammed paper
straight out slowly.

5 Ifthe head cleaning unit is open, push the head
cleaning unit without touching the print head to
close it.

Head cleaning unit

If you cannot remove the jammed paper from the
outside, go to the next step.

2 Setthe printer to standby mode by pushing the ON/
STANDBY button and turn the power of the printer
off by setting the main power switch to the off side.

3 Remove the auto sheet feeder tray.

Error Messages
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6  Pull the section with belts located inside the printer 9  Re-insert the auto sheet feeder tray.

up slowly and remove the paper jammed between
the openings. 10 pull out the output support completely.
If it is pulled out halfway, the paper may jam again.

Pull this section up
slowly.

If you can remove the jammed paper, go to step 8.
When the edge of the jammed paper can not be
seen, go to step 7.

oll the green roller back and forth so that the
7 Rollth g ller back and forth so that th
jammed paper comes out. Then remove it slowly.

/R
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Be careful not to touch any parts except the green
roller.

8 Reset the section with the belts as it was, after you
have removed the jammed paper, and then close the
main cover.

When resetting the section with belts, be sure to put
the shaft located at the front of the section into the
center groove. If you put the shaft into the wrong
groove, the printer may break.

58 Error Messages



Before Consulting Your
Dealer

Should the problem persist after you have applied the
remedies suggested in Troubleshooting, consult your
dealer on following points.

Is the printer malfunctioning?

The printer does not work or serious errors occur even
if you try to apply the suggested remedies, the printer
seems to be broken.

\ 4

Consult your dealer.

Is a computer malfunctioning?

If the printer works correctly and the printer driver is
installed correctly, the printer cable or computer
system (OS, memory, hard disk, interface, etc.) seems
to be the source of the trouble.

¥

Consult the dealer from whom you purchased the
computer or the computer manufacturer.

Is the application software malfunctioning?

If trouble occurs with special application software, this
may be a problem peculiar to that application software.

¥

Consult the dealer or the manufacturer of the application
software.

The problem may be solved if you upgrade the printer
driver to the latest version.

\ 4

For detailed information on how to upgrade the printer
driver, see the home page of the Sony ink jet printer.

Specifications

Printer

Printing system Line shot method
Printing speed  Standard: Approx. Sppm
Printing width Maximum 210mm
Receiving buffer
56MB
Interface Hi-Speed USB (USB2.0)
Interface connector
Printer side: USB regulation series B
receptacle
Cable side: USB regulation series B
plug
Ordinary noise level
Approx. 38dB or less (when the printer
is in standard mode)
Operating temperature
10°C to 35°C (50°F to 95°F)
Operating humidity
20% to 80% (no condensation allowed)
Storage and transport temperature
—10°C to 45°C (14°F to 113°F)
Storage and transport humidity
20% to 80% (no condensation allowed)
Temporary storage temperature in the user environment
0°C to 35°C (32°F to 95°F)
Temporary storage humidity in the user environment
20% to 80% (no condensation allowed)
Power requirements
100 to 240 V AC, 50/60 Hz
Input Current 4.0 to 1.6 A max. at 25°C
Power consumption
At standby: Approx. 16W or less
When printing: Approx. 70W
With the auto sheet feeder tray
Approx. 350 x 202 x 519 mm (w/h/d)
(13 7/8 x 8 x 20 1/2 inches)
When printing
Approx. 350 x 202 x 643 mm (w/h/d)
(137/8 x 8 x 25 3/8 inches)
Mass Approx. 15.5kg (34 1b 3 0z)
Sheet feeding system
Auto sheet feeding

Dimensions

Paper size A4

Print head Black:
Number of nozzles: 5120 x 1
Gray:

Number of nozzles: 5120 x 1
Supplied accessories
Plug holder (1)
Head cartridge (packed inside the
silver package) (1)
Auto sheet feeder tray (1)
Ink cartridges (black and gray) (2)

Before Consulting Your Dealer / Specifications
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Head cleaning unit (1)

USB cable (1)

High Quality Paper (1)

Setup Manual (1)

CD-ROM (including multi-lingual
operating instructions and setup
manuals, and printer drivers) (1)

Optional accessories

Ink cartridge  Black: EPI-L100BL Sony ink cartridge
Gray: EPI-L100GL Sony ink cartridge
Paper EPP-300A4MD Sony High Quality
Paper
Head cleaning roller
EPA-5CR

Medical Specifications

Protection against electric shock:
Class I

Protection against harmful ingress of
water:
Ordinary

Degree of safety in the presence of
flammable anesthetics or oxygen:
Not suitable for use in the presence
of flammable anesthetics or oxygen

Mode of operation:
Continuous

Environmental performance

Resource efficiency
Mass: Approx. 15.5kg (34 1b 3 oz)
Dimensions:
With the auto sheet feeder tray
Approx. 350 x 202 x 519 mm (w/h/d)
(13 7/8 x 8 x 20 1/2 inches)
When printing
Approx. 350 x 202 x 643 mm (w/h/d)
(13 7/8 x 8 x 25 3/8 inches)
Environment consideration
Harmful materials parts
All parts composing of the printer:
Special bromine flame retarder
(PBB, PBDE) are not used.
Exterior plastic:
Heavy metals (Pb, Hg, Cr (VI), Cd)
and halogen flame retarder are not
used.
Ordinary noise level
38dB (when the printer is in
standard mode)
Packing material
Heavy metals (Pb, Hg, Cr (VI), Cd) are
not used. (Carton)
Applied regulation
International Energy Star program

Specifications

Design and specifications are subject to change without
notice.

bnerit

As an ENERGY STAR Partner, Sony Corporation has
determined that this is product meets the ENERGY
STAR guidelines for energy efficiency.

Outline of the International ENERGY
STAR Office Equipment Program

The International ENERGY STAR Office Equipment
Program promotes energy saving through the use of
computers and other office equipment. The program
backs the development and dissemination of products
with functions that effectively reduce energy
consumption. It is an open system in which business
proprietors can participate voluntarily. The targeted
products are office equipment such as computers,
displays, printers facsimiles, and copiers. Their
standards and logos are uniform among participating
nations/regions.

Requirements for the Printer Driver

Computer

A computer on which Micrsoft Windows XP Home
Edition/Professional (English version) or Microsoft
Windows 2000 Professional (English version) runs.
Also, a computer equipped with a USB interface.

Basic software
Microsoft Windows XP (English version)
Microsoft Windows 2000 (English version)

Hard disk space required

Disk space required when installing the printer driver
(including the memory to be used temporarily):
25Mbytes

To connect a USB cable to a Windows

computer

It is necessary to use a computer which satisfies the

following conditions and a USB port that is guaranteed

by the computer maker.

¢ A computer on which either Windows XP or Windows
2000 is preinstalled

» Use the peripheral equipment which has obtained
USB 2.0 certification. If you use peripheral equipment
which is not certified, this may cause trouble. Also,



there are cases where the performance of the printer
cannot be guaranteed.
* Use a cable of less than 3m in length.

To connect the printer to Windows via a Hi-
Speed USB
Use the Microsoft Windows XP/2000 USB2.0 driver.

Do not use the extension USB 2.0 board such as PCI,
PCMCIA and so on since the operation may become
unstable.

This printer is applied to Hi-Speed USB.

When the printer is connected to the computer which
corresponds to Hi-Speed USB, the data can be loaded at
high speed (maximum 480Mbsp ),

If the printer is connected to the computer which does

not correspond to Hi-Speed USB, the down loading

speed is based the specifications of the computer.

a) 480Mbps is the maximum value on the theory of the
Hi-Speed transfer of USB2.0 regulation. The actual
transfer speed depends on the devices, conditions
and so on.

Specifications
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Menu Flow of the Printer
Window Display

The messages of the printer window display changes as
follows whenever you push the MENU button and you
can perform settings.

How to read the flow chart

* The arrow in the flow chart indicates that you push the
button.

« MENU, SET, BACK and <4<, »P indicate the
buttons on the operation panel of the printer.

* “_”indicates the blinking of the cursor, and this is the

status where the printer is waiting to push the SET or
BACK button.

processing in some operation.

Main flow
MENU, >
v
READY MENU | |nk level
Black (BL) i
READY ? «‘ "MENU,»
I
L Ink level
: Gray (GL) i
I << MENU,»>»
I Drint inh
- _ - —— — — | Print job !—> Go to “Job cancel” on page
! Lcancel | 64
: «T lMENU >p
e Cleaning. Go to “Head cleaning” on
:_ page 63
A
I << MENU,»»
| v
L Print test page. ———p Go to “Test printing” on
| page 63
| X
| < 4 MENU»>
I
L —— Replace roller. —» Go to “Cleaning roller
I replacement” on page 64
: «‘ "MENU,»
I . .
L Cleaning unit
A |
<<«
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Head cleaning

!

Cleaning.

A
BACK SET

Clean? < P>

SET

A

Yes

SET

r :
| Now cleaning

Clean?
NO_

Test printing

v

Print test page.

A
BACK SET

v

<< >

Test print?

SET

A

Yes

Brint test page, |
Test printing. |
i mi e

I
—

Test print?
No_

Menu Flow of the Printer Window Display
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Job cancel

v

Print job cancel

<< >

SET

v

A
BACK SET
v
Cancel print?
Yes_
SET
T aaning |
| Cleaning |
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Cancel print?
No_

Cleaning roller replacement

v

Replace roller.

A
BACK SET

Replace?

SET

<< P>

A\ 4

Yes

&S ET

{Warming up |

F N

r .
| Now cleaning

Replace?
No_

Menu Flow of the Printer Window Display




Setting Items for the
Printer Driver

Customer Confirmation
Sheet

When consulting with your dealer, write down the status
of the printer beforehand so that troubles can be solved
easier.

Model name of the
printer

Serial No.

Computer manufacturer

Computer OS [Windows2000 SP
[WindowsXP SP

Memory MB

Hard disk space GB

Connecting cable of the | USB cable

printer

Usage environment

Software application used
when printing

Software application

Manufacturer

Version

When printing other print
data

[] Prints correctly
[] Cannot print

When printing with
another software
application

[] Prints correctly
[] Cannot print

Printer driver

Version

Re-installation of the
printer driver

[] Re-installed
[] Not re-installed

Tab Item Selections |Default
setting
Main Tray Auto Sheet Auto Sheet
Feeder Feeder
Size A4 (Fixed) A4
Width 210 (Fixed) |210 (Fixed)
Length 297 (Fixed) |297 (Fixed)
Media Type | Sony high Sony high
quality coated | quality coated
paper/Plain | paper
paper
Ink Black and Black and
white (Fixed) | white
Gamma Gamma 1/ Gamma 1
Gamma 2/
Gamma 3/
Gamma 4
Orientation Portrait/ Portrait
Landscape
Printing 1page/2page/ | 1page
multiple 4page
pages per
sheet
Poster 4page (2 x 2)/ | 4page (2 x 2)/
9page (3 x 3)/
16page (4 x
4)
Function Stamp Text/Bitmap | Text
Setting...
Printing Front to Back | Front to Back
Order (from the first
page)/Back to
Front (from
the last page)
Sort Collate/By Collate
Sheet

Status

Symptoms

From when [] From long ago
[] Just lately

Frequency [] Every time

[[] Sometimes

The test pattern built in
the printer is printed
correctly.

[] Yes
] No

Setting Items for the Printer Driver / Customer Confirmation Sheet
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pinting without a stamp 32
removing stamp entries 32

Status monitor
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